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Purpose

This guide provides you with the information that you need to configure and
maintain Essbase® Integration Services and OLAP Metadata Catalog and to use
Essbase Integration Services Shell on all supported platforms.

Audience

Thisguideisfor Essbase Integration Services database administrators who are
responsible for implementing, configuring, and managing Essbase Integration
Services.

To use the information in this book, you need the following skills:

« Knowledge of where the data for your business resides (for example, in a
relational database).

« A fundamental understanding of Microsoft Windows and basic Microsoft
Windows terminology, such as dialog box, list box, and button.

See Microsoft Windows documentation for more information on these terms.

« For UNIX system users, afundamental understanding of UNIX system
administration, such as directory navigation, environment variables, login
scripts, and text file editing.

See the documentation for the UNIX system you are using for more
information.

« A fundamenta understanding of database administration, such as database
tables, columns and records, user management, operation of database client
utilities, and executing SQL commands.
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Document Structure

This document contains the following information:

Chapter 1, “Using Essbase I ntegration Server,” describes how to start and stop
the server and view the server error log.

Chapter 2, “Working with Users, Locks, and Permissions,” describes how to
view information about users, OLAP models and OLAP metaoutlines, and
how to manage access to documents within an OLAP Metadata Catal og.

Chapter 3, “Troubleshooting ODBC and Connections,” describes how to
diagnose and resolve problems with database and software component
connections, including Open Database Connectivity (ODBC) problems.

Chapter 4, “Tablesin OLAP Metadata Catalog,” describes the structure and
content of the OLAP Metadata Catal og.

Chapter 5, “Using Essbase Integration Services Shell,” describes the basic
operation and commands for the Essbase Integration Services Shell.

Appendix A, “Esshase Integration Server Error Messages,” details the error
messages generated by Essbase Integration Server.

Glossary, alist of key Essbase Integration Servicestermsand their definitions.

Index, alist of Essbase I ntegration Services terms and their page numbers. In
the online version, select an index entry to view that page.

Where to Find Hyperion Documentation

All Essbase Integration Services documentation is accessible from the following
locations:

viii =

Essbase | ntegration Services Information Map provides access to all Essbase
Integration Services documentation in PDF, Windows Help, and HTML
formats. The Information Map is located at

| SHOVE/ essi nt egrati on/ docs/ ei s_i nfo_map. ht m

Online helpisaccessible from the Essbase | ntegration Services Console. Start
the product and click the Help button on dialog boxes or use the Help menu
command. Online help includes procedural and conceptual information as
well as dialog box help and a glossary.
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« Intelligent Helpis displayed in adockable, relocatable window within the
Essbase | ntegration Services Console and provides procedural information
along with linksto automatic-detection options and frequently used functions.

« TheHyperion SolutionsWeb siteislocated at ht t p: / / www. hyper i on. com

« The Hyperion Download Center, if you have access

[1 To access the documentation from the Hyperion Solutions Support Web site:
1. Logontohttp://ww. hyperion.com.
2. Select Support from the menu bar.

3. Enter your user name and password, and click Log in.

Tip: If you do not have a user name and password, click Regi st er to request
this information.

Select Softwar e/Documentation, listed under Product Releases.
From the Product list box, select Hyperion Essbase OL AP Server.
From the Display list box, select Documentation, then click Submit.

N oo g A

Select the appropriate release of Esshase Integration Services to access the
documentation for that release.

Note: Not all Essbase Integration Services documents are available for viewing or
downloading from the Hyperion Solutions Web site.

[1 To access the documentation from the Hyperion Download Center:
1. Logonto http://wwmv hyperion. subscribenet.com

2. IntheLogin ID and Password text boxes, type your assigned login ID name
and password, and then click L ogin.

If you are amember on multiple Download Center accounts, select the
account you want to use for the current session.

Inthe Product List, select Hyperion Esshase.
4. Inthe New Releases tab, select Essbase | ntegration Services.

Select the Essbase | ntegration Services Release 6.5.1 Start Here link and
follow the steps listed for downloading the installation and product
documentation ZIP files.
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Conventions

The following table shows the conventions used in this document:

Table i: Conventions Used in This Document

Item Meaning

> Arrowsindicate the beginning of aprocedure consisting of
sequential steps.

Brackets|] In examples, brackets indicate that the enclosed elements
are optional.

Bold Bold in procedural steps highlights major interface

elements.

CAPITAL LETTERS

Capitd |etters denote commands and various I Ds.
(Example: LOADALL command)

Ctrl +0 K eystroke combinations shown with the plus symbol (+)
indicate that you should press the first key and hold it
while you press the next key. Do not type the + symbol.

Exanpl e t ext Courier font indicates that the material shown isacode or

syntax example.

Courieritalics

Courier italic text indicates avariable field in command
syntax. Substitute avalue in place of the variable shownin
Courier italics.

ARBORPATH When you see the environment variable ARBORPATHIn

| SHOVE italics, substitute the value of ARBORPATH from your site.
When you see the environment variable /| SHOVEin italics,
substitute the value of | SHOVE from your site.

Italics Italicsin aproduct-related term in the body of a book
indicates that the term is also included in the glossary
of the book.

n, X Italic n stands for a variable number; italic x can stand for

avariable number or an alphabet. These variables are
sometimes found in formulas.
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Table i: Conventions Used in This Document (Continued)

Item Meaning

Ellipses(...) Ellipsis points indicate that text has been omitted from an
example.

Mouse orientation This document provides examples and procedures using

aright-handed mouse. If you use aleft-handed mouse,
adjust the procedures accordingly.

Menu options Optionsin menus are shown in the following format.
Substitute the appropriate option names in the
placeholders, asindicated.

Menu name > Menu command > Extended menu
command

For example: 1. Select File > Desktop > Accounts.

Note: The term right-click, used throughout this guide, means to click the secondary
mouse button to open a pop-up menu.

Additional Support

In addition to providing the documentation and online help, Hyperion offers the
following support for product information:

How to Order Printed Documentation
To order printed documentation:
« Visit the Hyperion Solutions Web site at ht t p: / / www. hyper i on. com

« Inthe United States, call Hyperion Solutions Customer Support at
877-901-4975.

« From outside the United States, including Canada, call Hyperion Solutions
Customer Support at 203-703-3600. Clients who are not serviced by support
from North America should call their local support centers.
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Education Services

Hyperion offers a variety of training options, including instructor-led training,
custom training, and eTraining. This education covers al Hyperion applications
and technologies and is geared to administrators, end users, and information
systems (IS) professionals.

Instructor-led training is delivered in formats and in locations suited to Hyperion's
diverse, global customers. Hyperion Authorized Training Centers are certified to
deliver courses developed by Hyperion. Custom Education Services—training on
the configured and tail ored applications that employees use on the job—is another
option to enhance user productivity and to ensure smooth day-to-day operations.
A service caled e€Training—including computer-based training, Web-based
training, and interactive Virtual Classroom training—jprovides a cost-effective
means of giving users a hands-on introduction to product features and functions.
Computer-based training (CBT) and Web-based training (WBT) provide
high-quality, self-paced training at the user’s convenience, regardless of location.

For more information about training, contact your Regiona Education Manager
or visit the Hyperion Solutions Web site at ht t p: / / www. hyper i on. comto see
alist of al training classes.

Consulting Services

Hyperion Consulting Services assists customers in maximizing the use of, and the
return on investment in, Hyperion products. Experienced Hyperion consultants
and Hyperion Alliance Partners assist organizations in tailoring solutions to their
particular requirements, such as reporting, analysis, modeling, and planning.
Specific services include implementation consulting, custom business solutions,
dataintegration, and technical consulting. Additionally, Hyperion offersavariety
of Services Packages and Reviews.

For more information about Consulting Services, Services Packages and
Reviews, aswell asthe services offered by Alliance Partners, contact your local
consulting services representative, or visit the Hyperion Solutions Web site at
http://ww. hyperi on. comto seealist of all Hyperion Alliance Partners.
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Technical Support

Hyperion provides Web-based and tel ephone support to ensure that clientsresolve
product issues quickly and accurately. This support is available for all Hyperion
products at no additional cost to clients with a current maintenance agreement.

« For Web-based support, or to see complete information on
available support options, visit the Hyperion Solutions Web site
ahttp://ww. hyperion.com

« Inthe United States, call 877-901-4975 for Hyperion Solutions Customer
Support.

« From outside the United States, including Canada, call Hyperion Solutions
Customer Support at 203-703-3600. Clients who are not serviced by support
from North America should call their local support centers.

Documentation Feedback

Hyperion strivesto provide compl ete and accurate documentation. We value your
opinions on this documentation and want to hear from you. Send us your
comments by completing the survey available at ht t p: / / www. hyperi on. com

Essbase Integration Services System Administrator's Guide | Xiii


http://www.hyperion.com
http://www.hyperion.com

Xiv | Essbase Integration Services System Administrator's Guide



Using Essbase Integration
Server

This chapter describes Essbase Integration Server, how to start it, how to shut it
down, and how to view itslog file. This chapter contains the following topics:

« ‘“Introducing Essbase Integration Server” on page 15

« ‘“Starting Essbase Integration Server” on page 16

« “Shutting Down Esshase Integration Server” on page 26

« “Viewing the Essbase Integration Server Log” on page 27

Introducing Essbase Integration Server

Essbase Integration Server is a multithreaded server that serves as the bridge
between the relational data source, OLAP Metadata Catalog, and Essbase OLAP
Server. Essbase Integration Server performs the following tasks:

« Retrievesinformation about OLAP models and metaoutlines from OLAP
Metadata Catalog

« Generates SQL statements
« Retrieves datafrom the external data source
« Loads members and data into the Essbase database

Essbase Integration Server must be running if you want to use Essbase | ntegration
Services Console (the graphical user interface) or Essbase | ntegration Services
Shell (the command line interface).

Essbase Integration Services System Administrator’s Guide m 15



Using Essbase Integration Server

Starting Essbase Integration Server

Beforeyou start Esshase | ntegration Server, make sure that thefollowing programs
arerunning. These programs can reside on network server computers and need not
be on your local computer to be available to Essbase Integration Server.

16 =

Therelational database management system (RDBMS) with the relational
data source that contains the OLAP Metadata Catalog where the metadatais
stored

One or more RDBM Ssthat contain therelational data sourcesyou want to use
to create or modify an OLAP model or a metaoutline

Esshase OLAP Server also must be running if you need to create, change, or load
datainto an Essbase database or if you want to preview an Essbase database
outline.

You can start Essbase Integration Server by using one of the following methods:

From a command prompt
From the Windows Desktop Start menu

As aWindows service

Note: To start the server as a Windows service, you must first enable the Windows
service for Essbase Integration Server. See the Essbase Integration Services
Installation Guide for more information.

[l To start Essbase Integration Server from the command line:

1.

Type the executable name on the command line; for example, type
ol api svr
Note: If Essbase Integration Server does not start when ol api svr is executed

from the command line, the operating system path may not be updated correctly.
For more information, see the Esshase Integration Services Installation Guide.

If you want to change any default startup switches, type the command syntax
after the ol api svr command or add the switchesto theei s. cf g file (see
“Storing Startup Switch Information in eis.cfg” on page 24 for information).

Thevaluesfor startup switchesthat you type at the command line override any
startup switch values you have stored intheei s. cf g file.
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Using Esshase Integration Server

When entering parameters for startup switches at the command line, enclose
path names that contain spacesin quotation marks (" ). The following
example illustrates the syntax for passing the -E and -M options:

ol apisvr -E"c:\mnmy | ogs\eislog" -Mc:\ess 65\bin\essbase. ndb"

[1 To start Esshase Integration Server from the Windows Desktop Start menu:
1. Onthe Windows Desktop, click Start.

2. Select Programs > Hyperion Solutions > Essbase | ntegration Services >
Essbase I ntegration Server to display the Essbase Integration Server
window.

If you have stored startup switch settingsinei s. cf g, those settings override
the default settings when starting Essbase | ntegration Server from the
Windows Desktop Start menu.

[l To start Essbase Integration Server as a Windows service:
1. Accessthe Services dialog box.

« OnWindows NT, select Start > Settings > Control Panel, and
double-click Services.

«  OnWindows 2000, select Start > Settings> Control Panel, double-click
Administrative Tools, and then double-click Services.

« OnWindows XP, select Start > Control Pandl. Inthe Control Panel,
select Performance& M aintenance, and then Administrative Tools. In
the Administrative T ools window, double-click Services.

The Services dialog box is displayed with Essbase I ntegration Server inthe
list of services.

2. Select, but do not double-click, Essbase I ntegration Server.
3. If you want to change any default startup switches:

« OnWindows NT, enter the startup switchesin the Startup Parameters
text box.

« OnWindows 2000, select Action > Properties and enter the startup
switchesin the Startup Parameter s text box, and then click Start.

Essbase Integration Services System Administrator’'s Guide m 17
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« OnWindows XP, right-click Essbase I ntegration Server and select
Properties, enter the startup switchesin the Start par ameter s text box,
and then click Start.

Note: Any startup switch information that you enter in this step overrides the
startup switch information you may have added to the ei s. cf g file. (see “Storing
Startup Switch Information in eis.cfg” on page 24 for information). You must input
startup switch settings each time you start Essbase Integration Server as a
Windows service.

When typing the syntax for startup switches in the Startup Parameter s text
box on WindowsNT and 2000, or the Start par ameter stext box on Windows
XP, replace any single backslash (\) within a path name with two backslashes
(\\). Thefollowing exampleillustrates the syntax for passing the -E parameter
on the Windows platform:

-Ec:\\temp\\myserver

Additionally, on Windows NT and 2000, enclose path names that contain
spaces with\ . The following example illustrates the syntax for passing the
-M option on the Windows NT and 2000 platforms:

-M"c:\\Program Fil es\\ ess 65\\bi n\\ essbase. ndb\"

OnWindows X P, enclose path namesthat contain spaceswith quotation marks
(" "). Thefollowing example illustrate the syntax for passing the -M options
on the Windows XP platform:

-Mc:\\Program Fi | es\\ess 65\\bi n\\ esshase. ndb"
Start the service for Essbase Integration Server.
« OnWindows NT, click the Sart button.

« OnWindows 2000, select Action > Start. (If you changed any startup
switches as described in step 3, skip this step.)

« OnWindows XP, click Start. (If you changed any startup switches as
described in step 3, skip this step).

The Service Control message box is displayed. After afew secondsiit
disappears, and the Status field entry for Essbase Integration Server is
changed to Started.
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Using Esshase Integration Server

Essbase Integration Server Startup Switches

Use the switches specified in Table 1 to change the default settingsin these
instances:

« When starting Essbase | ntegration Server from the command line or asa
Windows service

« When storing startup switch informationintheei s. cf g file (asdescribed in
“Storing Startup Switch Information in eis.cfg” on page 24)

Table 1: Essbase Integration Server Switches

Switch Description

-? To view alist of available switches for starting Essbase I ntegration
Server, type - ? when you start Essbase Integration Server; for
example, type

ol api svr -7

-B To set the fetch size that Essbase Integration Server uses when
transferring rows from the data source to the Essbase database, type
- Bnunmber OF Rows when you start Essbase Integration Server. The
default number is 100 rows; the range is from 0 to 32767 rows.

To maximize performance, estimate the size in bytes of the rows
being loaded from the relational data source. Divide 64,000 by that
estimated size to determine the optimal number of rows to fetch.
The goal isto generate blocks of datathat are as close to 64 KB as
possible, without exceeding that amount. If the size of a block of
rows exceeds the 64 KB threshold, the load will fail.

For example, to set the number of rowsto 150, type
ol api svr -B150

Intheei s. cf g file, this parameter is specified in the following
format:

[ B] =150
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Table 1: Essbase Integration Server Switches (Continued)

Switch

Description

-C

To set the number of records that Essbase Integration Server commits
to Essbase during a data load, type - Cnunber of recor ds when
you start Essbase Integration Server. This setting specifiesthe
number of records to be committed to Esshase after all records are
sent. The default setting is all records.

The -C switch may be used concurrently with the -N switch.

The recommended setting for testing purposesis 5,000 to 10,000
records. After you have completed data load testing, shut down the
server to reset the number of records to the default setting of all
records. If you have included a setting for testing purposes for this
startup switchiin ei s. cf g, be sureto edit the file to clear the setting
back to al records.

Setting asmaller number of records during testing, such as after every
5,000 or 10,000 records have been transferred to Essbase, enablesyou
to see dataload errorsincrementally. Viewing the errors provides you
an opportunity to correct data source problems before continuing and
waiting for an entire data load to complete before you can take any
corrective actions. Resetting the number of records to the default of
all records resultsin faster performance, but error records are
viewable only at the completion of the dataload.

The number of records that Essbase Integration Server can transfer to
Essbase during adataload islimited to arange of 1 to 1,000,000,000.
Essbase can use dl available memory resources allocated to it.
However, if you experience memory problems during a dataload, set
-C toasmaller value.

For example, to set the number of records that Essbase | ntegration
Server incrementally transfers to Essbase during adata load, type

ol api svr -C5000
Note: This setting does not apply to member loads.

Intheei s. cf g file, this parameter is specified in the following
format:

[ ] =5000
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Table 1: Essbase Integration Server Switches (Continued)

Switch Description

-D Specifies whether to add the DISTINCT clause to the SELECT
statement of drill-through SQL. The default behavior isto add the
DISTINCT clause. If you do not want to add the DISTINCT clause,
type - DN when you start Esshase Integration Server.

For example, to specify that the DISTINCT clause should not be
added to drill-through queries, type

ol api svr -DN
Any other value or no value specifies that the DISTINCT clause
should always be added to drill-through SQL.

Intheei s. cf g file, this parameter is specified in the following
format:

[ D] =N

-E To givethelog file adifferent name, type- El og_fi | e_nane when
you start Esshase Integration Server. The. | og extension is added
automatically. The default name and location is

| SHOVE\ | og\ ol api svr. | og.

For example, to name the log filenyser ver . | og and put it in the
t enp directory on Windows, type

ol api svr -Ec:\tenp\nyserver

Do not typethe. | og file extension. The. | og extension is
automatically appended to the name you type for the log.

Enclose path names that contain spaces with quotation marks (" " );
for example, type

ol api svr -E"c:\programfil es\eis\nyserver"

Intheei s. cf g file, this parameter is specified in the following
format:

[ E] =c: \t ermp\ nyserver
or
[E] =c:\ program fil es\ ei s\ nyserver

Note: Inthe ei s. cf g file, you do not need to type quotation marks
around path names that contain spaces.
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Table 1: Essbase Integration Server Switches (Continued)

Switch Description

-F Specifies whether to add parentheses around user-defined
drill-through filters. See Esshase Spreadsheet Add-in help for
information on drill-through filters.

The default behavior is not to add parentheses around user-defined
drill-through filters. If you want to add parentheses , type - FY when
you start Essbase Integration Server.

For example, to specify that parentheses should be added around
user-defined drill-through filters, type

ol api svr -FY
Any other value or no value specifies that parentheses should not be
added around user-defined drill-through filters.

Intheei s. cf g file, this parameter is specified in the following
format:

[F] =Y
-L To set the level of detail of the messages that Essbase Integration

Server logs, type - LI evel when you start Essbase Integration
Server. The default level is 2.

For example, to use the highest level of logging, type
ol api svr -LO
You can specify the following levels:

0 tolog al debug messages and the ODBC SQL generated by
Essbase Integration Server

2 tolog al informational messages and some of the ODBC SQL
generated by Esshase Integration Server

3 tologal warnings
4 tolog all non-critical errors

7 tologall critical errors where Essbase Integration Server
terminates the command

8 tologal critical server errors
The recommended level settings are 2 or 3.

Intheei s. cf g file, this parameter is specified in the following
format:

[L]=0
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Table 1: Essbase Integration Server Switches (Continued)

Switch Description

-M To specify the location of the Essbase message database fileif it has
been moved to anew location, type - Mpat hl essbase. ndb when
you start Essbase Integration Server. The default location is
ARBORPATH bi n\ essbase. ndb.

For example, to specify the new location of essbase. ndb if you
moved the Esshase message database fileto essbase65\ bi n, type

ol api svr - M::\essbase65\ bi n\ essbase. ndb

Enclose path names that contain spaces with quotation marks (" ");
for example, type

ol api svr -M'c:\ess 65\ hi n\esshase. mdb"

Intheei s. cf g file, this parameter is specified in the following
format:

[ M =c: \ essbase65\ bi n\ essbase. ndb
or
[ M =c:\ess 65\bin\essbase. mib

Note: Inthe ei s. cf g file, you do not need to add quotation marks
around path names that contain spaces.

-N To specify the number of threads for executing SQL, retrieving data,
transforming it, and sending it to Essbase during a data load, type

- Nnunber _of _t hr eads when you start Essbase Integration
Server. The default setting is 1 thread.

The -N switch may be used concurrently with the -C switch.

The number of threads allocated to the Esshase Integration Server
dataload optimization processis controlled by the -N switch. For
optimal data load performance, a thread can be allocated to each task
in the data load process: executing the SQL statements, retrieving
data, transforming data, and transferring data to Essbase.

For example, to set the number of threadsto 3, type

ol api svr -N3

The recommended setting is eight times the number of processorsin

the computer containing the server component of Essbase Integration
Services.

Intheei s. cf g file, this parameter is specified in the following
format:

[N =3
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Table 1: Essbase Integration Server Switches (Continued)

Switch Description

-P To set the TCP port number with which Essbase Integration Server
communicates with its clients to a port different from the default
3388, type -Pportnumber when you start Essbase I ntegration Server
and the Essbase Integration Services Shell; for example:

ol api svr -P8850

ol api cmd - P8850

Intheei s. cf g file, this parameter is specified in the following
format:

[ P] =8850

If you set the port number to a value other than the default, in the
Essbase Integration Services Console you must log in to the
Integration Server by typing the server name or |P address and the
non-standard port number, separated by a colon; for example:

aspen: 8850

-T To set the number of network listenersthat Essbase I ntegration Server
starts, type - Tnunber when you start Esshase I ntegration Server.
The default number is 10. The recommended setting is 10.

Network listeners receive requests from Essbase Integration Services
Console. The server automatically adds and subtracts listeners as
needed, so the number of listeners set at startup does not limit the
number of usersthat can connect to an Esshase Integration Server.
For example, to set the number to 17, type

ol api svr -T17

Intheei s. cf g file, this parameter is specified in the following
format:

[T]=17

Storing Startup Switch Information in eis.cfg
Theei s. cf g fileisused for two purposes:

« Asanenvironment for Teradata and Oracle users to configure the required
JDBC drivers, as discussed in the Essbase Integration Services Installation
Guide.

« Asameansfor passing startup parameters, other than the defaults, when
launching Essbase | ntegration Server
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Theei s. cf g fileisatext file which resides in the\ bi n directory on both
Windows and UNIX platforms. When you start Essbase I ntegration Server from
the command line (in DOS or UNIX) or as a Windows service, the startup routine
first checksthe contentsof ei s. cf g for any startup switch information. After the
check of ei s. cf g contents, one of the following situations occurs, and then one
of the following situations occurs:

« If youadded startup switch syntax totheei s. cf g file, the default settingsfor
those switches (see Table 1) are overridden by the settings for the switches
that you added.

« Ifyoudid not add startup switchinformationtoei s. cf g, the default settings
(see Table 1) are used to start Integration Server.

« Ifeis. cfg contains startup switch syntax and you enter startup switch
overrides at the command line or when starting the server as a Windows
service, any switchesthat you enter override both the settings contained in the
ei s. cf g file and the default settings.

[l To store startup switch settngsintheei s. cf g file:
1. Opentheei s. cf g filein any text editor.

2. Addthestartup switch that you want to store by typing the startup switch | etter
in brackets; for example:

[ Bl

3. Add the new information for startup switchesin the following format; for
example:

[L]=0

[ E] =c: \t enp\ myserver

[ N] =40

[ M =c:\ess 65\ bin\essbase. nib

To enter the above overrides at the command line, type

ol api svr -LO -Ec:\tenp\nyserver -N40 -Mc:\ess 65\ bi n\ esshase. ndb"

4. Saveandcloseei s. cf g.
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Reconnecting When Connection is Lost

If you lose the connection to Integration Server you can reconnect directly from
Essbase | ntegration Services Consol e without losing any unsaved work.
[] To reconnect to Integration Server:

1. Start the server using one of the methods described in “ Starting Essbase
Integration Server” on page 16.

2. Inthe Essbase Integration Services Console, select Connections> OLAP
M etadata Catalog > Reconnect.

Note: The connection is made implicitly; no messages are displayed.

Shutting Down Essbase Integration Server

When you finish using Essbase Integration Server, shut it down by using any of the
following methods.

Note: Always close Esshase Integration Services Console before shutting down
Essbase Integration Server.

[1 To stop Essbase Integration Server from the command line, either close the
Essbase | ntegration Server window, or use Essbase Integration Services Shell.
«  OnWindows platforms, close the Essbase I ntegration Server window.
o Issuethe SHUTDOWN command in the Esshase | ntegration Services Shell.

For more information, see “Using Essbase I ntegration Services Shell
Commands” on page 91.

[1 To stop Essbase Integration Server from the Windows desktop:

1. Right-click thebutton representing Essbase Integration Server in the Windows
task bar.

2. Select Close.
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[l To stop Esshase Integration Server as a Windows service:
1. Select Start > Settings > Control Panel.
2. Open the Services dialog box.
o OnWindows NT, double-click Services.

« On Windows 2000, double-click Administr ative Tools, and then
double-click Services.

Locate Esshase Integration Servicesin the list of services.
4. Select, but do not double-click, Essbase Integration Services.
5. Stoptheservice.

« OnWindows NT, click Stop and then click Y es at the prompt to confirm
that you want to shut the Windows service for Essbase I ntegration
Services.

« OnWindows 2000, select Action > Stop.

The Service Control message box is displayed. After adelay, it disappears
and the Status field for Essbase Integration Servicesis changed.

Viewing the Essbase Integration Server Log

By default, the Esshase Integration Server log fileis named ol api svr. | og and
islocated inthe / SHOVE\ | og directory. You can view it from Essbase Integration
Services Console by selecting the Tools > View Log File command to launch the
Server Log file dialog box. You can also view thelog by opening ol api svr. | og
in any text editor. To create the log file with a different location or name, use the
-E switch. For more information, see Table 1.

The following items are logged in the Essbase Integration Server log file,
depending on the logging level that you set when you start the server:

« All error messages

« The settings for switches used to start Essbase Integration Server from the
command line or as a Windows service
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Two copies of each SQL statement generated to access the relational data
source as follows:

— Thefirst SQL statement isin the SQL dialect understood by the ODBC
driver and is generated by the Essbase Integration Server.

— The second SQL statement is generated by the ODBC driver and is
translated by the driver in the dialect of SQL understood by the RDBM S
being accessed.

The Essbase Integration Services Shell commands used to perform an action
Connection information

Notification of the success or failure of aload

The name, if applicable, of the metaoutline that is running

Other informational messages

Additionally, when a user accesses a drill-through report using Essbase
Spreadsheet Add-in, the following items related to the drill-through report are
logged in the Essbase Integration Server log file:

The name of the drill-through report

The name of the metaoutline with which this drill-through report is associated
The name of the Essbase server that is being accessed

The Essbase application name and database name

The user 1D of the user accessing this drill-through report

For more information on setting the logging level, see Table 1.

Essbase error message text is located in | SHOVE\ bi n\ nessage. t xt on
Windows systems; $| SHOVE/ bi n/ message. t xt on UNIX.
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and Permissions

This chapter describes how to view information about users, OLAP models, and
metaoutlinesin OLAP Metadata Catal og. It also describes how to clear locks and
change permissions on OLAP models and metaoutlines.

This chapter contains the following topics:

« “Working with Users’ on page 29

« “Working with Locks” on page 30

« “Working with Permissions’ on page 34

For more information about OL AP Metadata Catalog, see Chapter 4, “Tablesin
OLAP Metadata Catalog.”

Working with Users

When working with Essbase Integration Services, you must manage access for
three types of users:

» Essbase Integration Services users. these users can access OLAP models and
metaoutlinesstoredin OLAP Metadata Catal ogs. Essbase I ntegration Services
users are the database users defined in the relational database that containsthe
OLAP Metadata Catalog you are using.

« [Essbase users: these users can access the Essbase database that you create
from a metaoutline.

« Source database users; source database users are defined in the relational
database management system (RDBM S) that manages the source database.
These users can access the tables and views in the relational source database.
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Use the tools provided with each relational database to manage each set of users.
Consult the relational database documentation if you are not sure how to perform
any of the following tasks:

» Create new users

« View alist of available users

« Change the permissions for users
« Delete current users

« Disconnect users

Working with Locks
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You can use either of two methods for opening an OLAP model or metaoutlinein
Essbase | ntegration Services Console: standard access mode (the default mode)
and exclusive access mode. Thelocksthat are established by these different modes
are specific to Essbase Integration Services and are completely separate from the
locking performed by the RDBMS.

Tip: If you plan only to view an OLAP model or metaoutline, use standard access
mode. If you plan to edit an OLAP model or metaoutline, use exclusive access mode.

Using Standard Access Mode

When you open an OLAP model in standard access mode, Essbase Integration
Servicesgivesyou aread lock on that OL AP model. When you open ametaoutline
in standard access mode, Essbase I ntegration Servicesgivesyou aread lock on that
metaoutline and aread lock on the OLAP model on which the metaoutline is
based. M ultiple users can have read locks on the same OL AP model or metaoutline
at the sametime.

When you save an OLAP maodel or metaoutline in standard access mode, Essbase
Integration Services upgrades the read lock to awrite lock for the duration of the
save. After Essbase Integration Services saves the changes to the OLAP model or
metaoutline, the lock reverts back to aread lock. However, if other users have the
OLAPmodel or metaoutline open, your changes are not updated for the other users
until they reopen the document. In addition, if other users have the OLAP model

or metaoutline open at the same time as you do, they can edit and save it, thereby
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overwriting your changes. Using exclusive access mode prevents users from
overwriting your changes. For more information, see “Using Exclusive Access
Mode” on page 31.

[1 If you have opened and edited an OLAP model or metaoutline in standard access
mode, and are concerned that other users may overwrite your changes, perform
one of the following steps:

« Savethe OLAP model or metaoutline using a different name. For more
information, see the Esshase Integration Services Console Help.

« If you have not yet started editing the document or have entered only a
few changes, close the OLAP model or metaoutline; then reopen it using
exclusive access mode and reapply the changes.

« Contact the users with read locks and ask them to close the OLAP model or
metaoutline. To view alist of users with read locks, see “Viewing Esshase
Integration Services Users with Locks’ on page 32.

Using Exclusive Access Mode

Opening an OLAP model or metaoutline in exclusive access mode eliminates the
risk of other users overwriting your changes. When you open an OLAP model in
exclusive access mode, Essbase | ntegration Services gives you awritelock on that
OLAP model that remainsin effect until you close the model. When you open a
metaoutline in exclusive access mode, Essbase I ntegration Services gives you a
write lock on that metaoutline and aread lock on the OLAP model on which the
metaoutline is based that remains in effect until you close the metaoutline. While
you have an OLAP model or metaoutline open in exclusive access mode, other
users can open and view the documents, but they cannot save them.

Correcting Problems with Locks

Due to the complex nature of Essbase Integration Services and the other software
components with which it interacts, you may experience problems that result in
locks not being released from OLAP models or metaoutlines. Unreleased locks
can result in an inability to save, even if no other users are on the system.
Unreleased locks can also prevent you from opening an OLAP model or
metaoutline.
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If you suspect that unreleased |ocks remain from previous sessions, delete the
locks by selecting Servers > OL AP Metadata Catalog > Delete Locks. Deleting
locks from the menu removes only your locks; it does not delete locks held by
other users.

If you suspect that unreleased locks remain from other user sessions, check to see
which users have locks. For more information, see “Viewing Essbase Integration
Services Users with Locks” on page 32. If you are convinced that some or all of
thelocksarefrom terminated user sessions, del etethem. For moreinformation, see
“Deleting Locks for Esshase Integration Services Users’ on page 34.

Viewing Essbase Integration Services Users with Locks

The CB_CONCURRENCY tablein OLAP Metadata Catalog contains
information about the users who access OL AP models and metaoutlines.
This table contains the following columns:

« CB_USER_NAME: the name of the user accessing the OLAP model or
metaoutline; for example, sa.

« CB_USER _SESSION_ID: asystem-generated reference number that
uniquely identifies an editing session

« CB_OBJECT_ID: an OLAP modd or metaoutline number

« CB_OBJECT TYPE: atype reference that indicates whether the user is
accessing an OLAP model or a metaoutline

—  The number 1 represents an OLAP model.
— The number 2 represents a metaoutline.

« CB_OBJECT_LOCK: alock reference number that indicateswhether the user
has aread or write lock

—  The number 1 represents aread lock.
—  The number 2 represents a write lock.
« CB_LOCK_TIMESTAMP: the date and time that the user acquired the lock
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[l To determine which users are accessing a specific OLAP model or metaoutline:

1.
2.
CB_USER_NAME
sa
sa
sa
Sa

Enter the following SELECT statement in the OLAP Metadata Catalog
database, using the tools for the relational database you are using:

SELECT CB_USER NAME, CB_OBJECT |D, CB OBJECT TYPE,
CB_OBJECT_LOCK, CB_LOCK TI MESTAVP
FROM CB_CONCURRENCY

View the results.

In the following example, the sa user isthe only user currently accessing an
OLAP model or metaoutline. The sa user has two read locks on one OLAP
model and one read lock each on two different metaoutlines.

CB_OBJECT | D CB_OBJECT TYPE CB OBJECT LOCK CB_LOCK_TI MESTAMP

889844639 1 1 Apr 9 2001 4: 43PM
889845263 2 1 Apr 9 2001 4: 43PM
889844639 1 1 Apr 9 2001 5:20PM
892167813 2 1 Apr 9 2001 5:20PM

(4 rows) affected)

You can determine the following information from the sample
CB_CONCURRENCY table shown in the preceding list:

« Thefirst row of the results tells you that the sa user
(CB_USER_NAME = s3) hasaread lock (CB_OBJECT_LOCK =1)
on an OLAP model (CB_OBJECT_TY PE = 1) with an ID of 889844639.

« The second row of the results tells you that the sa user
(CB_USER_NAME = sa) hasaread lock (CB_OBJECT_LOCK =1) on
ametaoutline (CB_OBJECT_TY PE = 2) with an ID of 889845263.

« Thethird row of the results tells you that the sa user
(CB_USER_NAME = sa) hasaread lock (CB_OBJECT _LOCK =1)on
an OLAP model (CB_OBJECT_TYPE = 1) with an ID of 889844639.

« Thefourth row of the resultstells you that the sa user
(CB_USER_NAME = sa) hasaread lock (CB_OBJECT _LOCK =1)on
ametaoutline (CB_OBJECT_TY PE = 2) with an ID of 892167813.

When you open ametaoutline, you receive aread lock on the metaoutline and
on the OLAP model on which it is based; therefore, you can assume that the
sa user isworking on two different metaoutlines based on the same OLAP
model.
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Deleting Locks for Essbase Integration Services Users

If you are certain that the other users who have read or write locks on an OLAP
model or a metaoutline that you want to save do not need their locks, delete their
locks from the CB_ CONCURRENCY table.

CAUTION: Make sure the users do not need their locks before you delete
the locks.

[ To delete read and write locks on OLAP models or metaoutlines:

1. Determine which users have locks.

See " Viewing Essbase Integration Services Users with Locks’ on page 32.
Delete the rows containing the unwanted locks.

For example, to delete all locks held by the sa user, issue the following
DELETE statement in the OLAP Metadata Catal og database, using the tools
for the relational database:

DELETE FROM CB_CONCURRENCY WHERE CB_USER NAME = 'sa'

Working with Permissions

When you save an OLAP model or metaoutline for the first time, you determine
what read or write permissions other users have. Esshase Integration Services
supports the following kinds of permissions:
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Allow read/write accessfor other users. This setting permits all other usersto
read and write to the OLAP model or metaoutline. This setting is the default.

Allow read access for other users. This setting permits all other usersto read
but not write to the OLAP model or metaoutline; that is, other users cannot
save changes to the OLAP model or metaoutline.

Disallow all access for other users. This setting denies all other users read or
write permission to the OLAP model or metaoutline. You are the only user
who can read or writeto it.

Essbase Integration Services System Administrator's Guide



Working with Users, Locks, and Permissions

[l To change the permissions of an OLAP model or metaoutline, take one of the
following actions:

Change the OLAP model propertiesin Essbase I ntegration Services Console.
For more information, see the Essbase Integration Services Console Help.

Save the metaoutline with a different name by selecting File > Save As. For
more information, see the Essbase I ntegration Services Console Help.

To edit tables containing the permissions for the OLAP model or metaoutline,
use the tools provided with the relational database that contains OLAP
Metadata Catalog. For more information on the tables to edit, see “Viewing
Permissions for OLAP Models’ on page 35 or “Viewing Permissions for
Metaoutlines’” on page 36.

Viewing Permissions for OLAP Models

Information about the permissions that are set for OLAP models and metaoutlines
is stored in OLAP Metadata Catalog. View thisinformation by selecting the
appropriate columns from tablesin OL AP Metadata Catal og.

The OM_INFO tablein OLAP Metadata Catal og contains information about
OLAP models, including the following columns which are relevant to
permissions:

MODEL _ID: a system-generated reference number.
MODEL_NAME: the name of the OLAP model; for example, TBC Model.

MODEL_DESCRIPTION: a description of the OLAP model. If you do not
enter a description when you save the model, this column is blank.

MODEL_DATA_SOURCE: the name of the Open Database Connectivity
(ODBC) data source on which the OLAP model is based; for example, TBC.

MODEL_OWNER: the login name of the OLAP model owner; for example,
sa. Thelogin nameis specified in the relational database that contains the
OLAP Metadata Catal og.

MODEL_ACCESS CODE: areference number that indicates what level of
access users, other than the owner, have to the OLAP mode.

—  Thenumber O represents no permissions—other users can neither read nor
writeto the OLAP model.
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— The number 1 represents read access—other users can read the OLAP

model but cannot write to it.

— Thenumber 2 representsread and write access—other users can both read

and write to the OLAP model; thisis the default.

[l To view access permissions for all OLAP modelsin OLAP Metadata Catal og:

1.

Issue the following SELECT statement in the OLAP Metadata Catalog
database, using the tools for the relational database.

SELECT MODEL_ NAME, MODEL_ OANER, MODEL _ ACCESS _CODE
FROM OM_| NFO

View the results.

In the following example, TBC Model gives read and write permissions
to other users (MODEL_ACCESS CODE = 2). TBC_Mod_Archive
gives read permissions to other users (MODEL_ACCESS CODE =1).
TBC_Mod_Mine gives neither read nor write permissions to other users
(MODEL_ACCESS_CODE = 0).

MODEL_ NAME MODEL_OMER  MODEL_ACCESS_ CODE
TBC Model sa 2
TBC_Mod_Ar chi ve sa 1
TBC_Mbd_M ne sa 0

(3 rows) affected)

Viewing Permissions for Metaoutlines

OLAP Metadata Catal og stores information about the permissions set for OLAP
models and metaoutlines. View this information by selecting the appropriate
columns from tables in OLAP Metadata Catalog.

The MO_INFO tablein OLAP Metadata Catal og contains information about
metaoutlines, including the following columnswhich are relevant to permissions:

MO_ID: asystem-generated reference number for the metaoutline.

MODEL_ID: a system-generated reference number for the OLAP model on
which the metaoutline is based.

MO_NAME: the name of the metaoutline; for example, TBC Metaoutline.

MO_DESC: adescription of the metaoutline. If you do not enter a description
when you save the metaoutline, this column is blank.
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MO_CHANGE_DATE: the date on which changes were last made to the
metaoutline.

MO_OWNER: the login name of the metaoutline owner; for example, sa.
The login nameis specified in the database that contains the associated OLAP
Metadata Catal og.

MO_ACCESS CODE: areference number that indicateswhat level of access
users, other than the owner, have to the metaoutline.

—  Thenumber O represents no permissions—other users can neither read nor
write to the metaoutline.

— The number 1 represents read access—other users can read the
metaoutline but cannot writeto it.

—  Thenumber 2 representsread and write access—other users can both read
and write to the metaoutline; this setting is the defaullt.

[1 To determine the access permissions for all metaoutlinesin OLAP Metadata
Catalog:

1.

2.

Issue the following SELECT statement in the OLAP Metadata Catalog
database, using the tools for the relational database.

SELECT MO _NAME, MO OWKNER, MO ACCESS_CODE
FROM MO_| NFO

View the results.

In the following example, TBC Metaoutline gives read and write permissions
to other users (MO_ACCESS CODE = 2). TBC_Archive gives read
permissions to other users (MO_ACCESS CODE = 1). TBC_Mine gives
neither read nor write permissions to other users (MO_ACCESS CODE = 0).

MO_NAME MO_OANER MO_ACCESS CODE
TBC Met aoutli ne sa 2
TBC_Archive sa 1
TBC_M ne sa 0

(3 rows) affected)
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Troubleshooting ODBC and
Connections

Essbase Integration Services requires several layers of software components to
connect to relational databases and load data into Essbase databases. Each of the
components must be configured properly to run and communicate with each other.
Consequently, diagnosing and correcting connection problems in the system can
be challenging.

This chapter assists you in isolating and correcting connection problems that can
occur during the operation of Essbase Integration Services. The first topic of this
chapter lists common causes for connection problems. The subsequent topics
outline a strategy for isolating and correcting connection problems not addressed
by the common problems list.

This chapter assumesthat you know how to perform basic database administration
tasks, such as using a database client utility program to connect to a database
server, navigating directories using acommand prompt, and editing configuration
files.

This chapter contains the following topics:

« “Common Connection Problems’ on page 40

« ‘“Database-Specific Problems’ on page 42

« “About ODBC and Connection Problems” on page 43
« ‘“lsolating Connection Problems” on page 44

« “Correcting Connection Problems” on page 60

« “Using ODBC Tracing” on page 70
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Common Connection Problems

If you have problems connecting to OL AP Metadata Catal og or to the external data
source with Essbase Integration Services Console, review the following list of
common problems:
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« Areyou using the correct user name and password?

Does the user name you used have the correct privileges to access both
OLAP Metadata Catalog and the data source at the database level?

If you are trying to connect to OLAP Metadata Catal og, did you use the
same user name and password as the user who created thetablesin OLAP
Metadata Catalog?

If you create an OLAP Metadata Catalog when logged in as one user
name, you cannot access the tablesin OLAP Metadata Catalog using a
different user name unless you create an alias for the user name (for
Microsoft SQL Server) or synonyms for the tables (for DB2 and Oracle).
For more information, see the Essbase Integration Services Installation
Guide.

« Areall of the following required components up and running?

Essbase | ntegration Server

Therelational database management system (RDBMS) listener for OLAP
Metadata Catalog and the data source

The database servers that manage OLAP Metadata Catalog and the data
source databases

« Isthedatabaseclient softwareinstalled and configured on the computer where
Essbase I ntegration Server isinstalled?

Do the database client software utility programs, such asthe
command-line SQL utility, run? Can you connect to databases with them?

Does the user who starts Essbase Integration Server have the correct
environment variables set and the necessary access privileges to run
the database client software?
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— Aretherequired environment variables for the database client software,
such as the path (and the library path on UNIX), configured on the
computer where Essbase Integration Server isinstalled?

OnUNIX, usei vt est | i b located in the | SHOVE/ bi n directory to
confirm that the library path contains al files required by the Open
Database Connectivity (ODBC) driver.

— If necessary, isthebi n directory for each databasein the operating system
path of the user who is running Essbase Integration Server?

— Doesthe ODBC Data Source Name (DSN) configuration identify the
name of the relational database management system (RDBMS) client?

OnUNIX, usetheodbcconfi g utility to check the path and environment
variable, and to test connectivity to ODBC.

« Are OLAP Metadata Catalog and the data source configured as (ODBC)
data sources on the Essbase | ntegration Server computer? For information
on configuring ODBC data sources, see the Essbase Integration Services
Installation Guide.

« Areyou using the ODBC data source names for OLAP Metadata Catalog and
the data source databases as configured on the Essbase Integration Server
computer? Do not assume that the RDBM S database name is the same as the
ODBC data source name for that database.

« Areyou experiencing time-out problemswhen connecting to the external data
source?

Wait and retry the action when the RDBM Sisless busy. To avoid the problem,
increase the ODBC driver time-out limit using ODBC Administrator on
Windows systems. For more information, see the ODBC documentation.

« Didyou createtablesin OLAP Metadata Catal og? For information on creating
tablesfor the catalog, see the Essbase I ntegration Services Installation Guide.

« Areyou having problemsrelated to ODBC while you are creating an Essbase
outline?If so, turn on tracing, perform the action again, and analyzetheresults
in the tracing log file. For more information, see“Using ODBC Tracing” on

page 70.

If you experience problems connecting to the RDBMS, view the log for the data
source for information about why the connection failed. For moreinformation, see
the documentation for the RDBM S you are using.
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If none of the above steps help, review the list of database-specific problemsin
“Database-Specific Problems” on page 42.

Database-Specific Problems

If you have problems connecting to OL AP Metadata Catal og or to the external data
source with Essbase Integration Services Console, review the following list of
common problems for specific RDBMSs:

DB2: You may be required to bind the database client software utilitiesto a
DB2 server that is managing the databases you want. For more information,
see the DB2 installation documentation.

Oracle: In configuring Oracle products to work with ODBC on UNIX
systems, you must configure the database namesin at nsnamnes. or a fileon
the computer that runs Essbase I ntegration Server. For more information, see
the Oracle installation documentation.

OCI: If connection attempts using Oracle OCI fail, be sure that when logged
in as the Essbase I ntegration Services user (the user who installed Integration
Services) on the server, you can successfully connect to the Oracle database
using SQL*Plus. The name for the database that worksin SQL* Plus should
work in Esshase Integration Services when referred to as Oracle:Net Service
Name (if you are using tnsnames) or Oracle:oname (if you are using Oracle
onames).

SQL Server: If youtry to access an SQL Server database with the Microsoft
native ODBC driver when you do not have access permission, SQL Server
connects you to the default database and does not notify you. Configure the
ODBC DSN to use the database that you want to access. For more
information, see the SQL Server documentation.

If none of the previous suggestions help, proceed to “ About ODBC and
Connection Problems’ on page 43 for an overview of connection problems,
then see “Isolating Connection Problems” on page 44.

42 m
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About ODBC and Connection Problems

There are three layers of software components that Essbase I ntegration Services
Console must pass through to contact an RDBMS: Essbase Integration Server,
ODBC, and the database client software. Failure within or between any of these
components can cause alack of communication between the console and the
RDBMS.

Diagnosing and correcting connection problemswith Essbase | ntegration Services
can prove difficult, because different connection problems often have similar
symptoms. In most cases, the errors received in Essbase Integration Services
Console are not sufficient to diagnose and resolve the problem, and you must go
to the server system to get more information and find a resolution.

The three main categories of problems that break the lines of communication
between Esshase Integration Services Console and the RDBMS are:

«  Software component problems:

— The components of Esshase Integration Services or the RDBMS are not
installed or are installed on the wrong compulter.

— The components do not run because they are not set up properly.
— The components stopped running or were never started.
— The components are not compatible with the operating system.

— Theversions of the different components are not compatible with each
other.

« Configuration and communication problems:

— The software components are not properly configured to communicate
with each other.

— User names, passwords, and permissions are configured or used
inconsistently across the components and computers.

— The communication interfaces of the software components are
incompatible with each other.

— Changes to components, databases, users, or permissions have put the
software components out of sync with each other.
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« Network and security problems:

— A physical network path does not exist between the computers that must
communicate with each other.

— One or both computers attempting to communicate do not have the
TCP/1P network protocol installed or configured.

— The computer attempting to contact another computer does not have
access to addressing information, such as a domain name server (DNS).

—  Security systems prevent all communication or certain types of
communi cation between the computersthat must talk with each other. For
example, thisisthe case when client and server computers are separated
by afirewall.

Isolating Connection Problems

44 m

If the list of problems provided in “Common Connection Problems” on page 40
and your own knowledgefail to resolve the connection problem, the recommended
strategy for diagnosing the problemsisto test the components and connections
starting at the RDBM S and backtracking through the connections to Essbase
Integration Services Console.
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The client software must pass through three layers of componentsto connect to the
RDBMS containing OLAP Metadata Catal og and the data source, asillustrated in
Figure 1.

Figure 1: Essbase Integration Services Components and Connections
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The numbersin Figure 1 identify the general diagnostic steps that you should take
to isolate connection problems. Follow these steps as indicated, starting with the
connection between the database client software and the RDBM S (1) and working
backwards through the system to isolate connection problems. After you isolate a
problem, refer to the appropriate components topic in “ Correcting Connection
Problems” on page 60.
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[l To isolate connection problems:

1.

Attempt to connect to the RDBM S databases using a database client utility
program. For moreinformation, see “ Testing the Database Client Connection
to the RDBMS” on page 46.

Attempt to connect to the RDBM S databases using ODBC. For more
information, see “ Testing the ODBC Connection to the RDBM S’ on page 48.

Attempt to connect to the RDBM S databases using Esshase Integration
Server. For more information, see “Testing the Essbase Integration Server
Connection to the RDBMS” on page 53.

Attempt to connect to the RDBM S databases using Esshase Integration
Services Console. For moreinformation, see“ Testing the Essbase I ntegration
Services Console Connection to the RDBMS’ on page 56.

Attempt to connect to Essbase OL AP Server using Esshase Integration Server.
For moreinformation, see” Testing the Essbase I ntegration Server Connection
to Essbase OLAP Server” on page 57.

Attempt to connect to Essbase OLAP Server using Essbase I ntegration
Services Console. For moreinformation, see“ Testing the Essbase Integration
Server Connection to Essbase OLAP Server” on page 57.

Testing the Database Client Connection to the RDBMS

Attempting to connect the database client software to the RDBMS you are using
isthefirst step toward isolating connection problems in Essbase Integration
Services. Once you have verified that these components are communicating
properly, you have agood base from which to test the remainder of the connection
chain.

Themost likely cause of aconnection failure at this point isthat the database client
software environment variablesare not included in thelogin script for the user who
runs the Essbase Integration Server program.

[ To test the database client connection to the RDBMS:

1.

Log on to the computer running Essbase Integration Server as the user who
starts the Essbase I ntegration Server program (typically, hyperion).

Note: Logging on as a different user, such as an administrative user, may fail to
reveal problems in the configuration.
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2. Start adatabase client utility program with which you can use SQL statements
to connect to and query databases, such as a command-line SQL utility.

If the database client utility does not start, check to make sure the client
softwareisinstalled and the required environment variables are set. For more
information, see “ Correcting Database Client Problems” on page 63.

3. Connect to the OLAP Metadata Catal og database in the RDBM Susing avalid
database user account.

If the connection fails, try to connect as a user who you know has access
permission, such as an administrative user. If the administrative connection
succeeds, check the other user accounts and permissionsin the RDBMS for
the OLAP Metadata Catal og database, and carefully check user accounts with
connection problems. For more information see, “ Correcting RDBM S
Problems” on page 62.

4. Executean SQL select statement against atablein the OLAP Metadata
Catalog database; for example, if you are connected to the sample OLAP
Metadata Catalog, type

SELECT * FROM TBC. OV_I NFO

If the select statement fails, check the permissions for the user name you are
using to connect to the RDBMS. For more information, see “ Correcting
RDBMS Problems” on page 62. Also, check that the version of the database
client software you are using is compatible with the version of the RDBMS.
For moreinformation, see“ Correcting Database Client Problems” on page 63.

5. After you have successfully completed the preceding steps, try connecting to
OLAP Metadata Catalog from Essbase Integration Services Console.

For more information, see “ Testing the Essbase I ntegration Services Console
Connection to the RDBMS’ on page 56. If the connection fails, proceed to
“Testing the ODBC Connection to the RDBMS” on page 48.

If you still cannot complete a connection and select statement with the user
who runs Essbase Integration Server, contact technical support for the
RDBMS.

6. Repeat step 3 through step 5 for the data source database.

After you have successfully connected to OLAP Metadata Catal og, you can
rule out setup and environment problems on the Essbase I ntegration Server
computer and concentrate on problems specific to the data source database,
including required database server names, database names, user names,
passwords, and access permissions.
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Testing the ODBC Connection to the RDBMS

After you have established that the database client software and RDBMS are
communicating properly, the next step in isolating connection problemsisto
test the ODBC connection to the RDBM S databases.

On Windows NT, Windows 2000, and Windows X P, use ODBC Administrator to
test connections to the RDBM S databases. In UNIX, usethe odbcconfi g utility
to verify ODBC configuration, manually inspect the ODBC configuration files
usingi vt est | i b provided with Essbase Integration Services or by using
DenpODBC (available from Hyperion Solutions Technical Support), or use
third-party or RDBM S-provided utilities.

On UNIX systems, the most likely causes for problemsin the ODBC component
are that the environment variables for ODBC have not been set up or that the
odbc. i ni file has not been configured properly.

ODBC tracing can also be used to track down connection problems. For more
information, see“Using ODBC Tracing” on page 70.

Testing ODBC on Windows Systems

To test ODBC connections to the RDBM S databases:

1. OntheWindowsdesktop, select Start > Settings> Control Panel to openthe
Control Panel window.

2. Inthe Control Panel window, perform one of the following steps:
« On Windows NT, double-click the ODBC Data Sour ces icon.

« On Windows 2000 and X P, double-click the Administrative Toolsicon,
and then double-click the Data Sour ces (ODBC) icon.

3. Inthe ODBC Data Source Administrator dialog box, click the System
DSN tab.

4. Inthe System Data Sour ceslist, select the data source created for the OLAP
Metadata Catalog or the data source database, and click Configure.

A data source configuration dialog box is displayed. Depending on the
RDBMS and the driver you are using, you may be asked to log on to the
database immediately, or you may be asked to review all the settings before
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testing the connection. In either case, after attempting to log on to the
database, observe the resulting message boxes to determine if you connected
to the RDBMS successfully.

Note: To be accessible from other computers, ODBC data sources must be
configured as System DSNs, not User DSNSs.

5. If you cannot connect to the database, check the server name, database name,
user name, and password information for accuracy, and make surethat you are
using the correct ODBC driver for the RDBMS.

For more information, see “Correcting ODBC Problems’ on page 65.

6. After you have successfully completed the preceding steps, try connecting to
the RDBMS from Essbase Integration Services Console.

For more information, see “ Testing the Essbase I ntegration Services Console
Connection to the RDBMS” on page 56.

If the connection from Essbase I ntegration Services Console fails, proceed
to “ Testing the Essbase Integration Server Connection to the RDBMS’ on
page 53.

Testing ODBC on UNIX Systems

OnUNIX systems, you usetheodbcconf i g utility to verify, add, or delete ODBC
connections. You can use odbcconf i g to perform preliminary testing. You must
inspect the configuration files for ODBC manually or use an RDBM S utility to
perform more thorough testing. These configuration filesinclude the login scripts
that set the environment variables for ODBC and the odbc. i ni file. For more
information about ODBC utilitieson UNIX systems, see thedocumentation for the
RDBMS or the ODBC driver.

DB2: To usethe odbcconfi g utility with DB2, the environment variable
INSTHOME must be set to the DB2 installation directory name, and exported.

Teradata: Tousetheodbcconf i g utility with Teradata, theenvironment variable
TDODBC must be set to the Teradata installation directory name, and exported.
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[l To verify and add an ODBC connection using the odbcconf i g utility:

1.

Log in to the computer that runs Essbase Integration Server as the user who
starts the Essbase I ntegration Server software.

Start the odbcconf i g utility.

Verify that the environment settings displayed by the odbcconf i g utility
are correct.

To edit and test the ODBC data sources, the available options are: List, Add,
Delete, Test, and Exit.

To list available DSNs, type 1 and press Enter.
Verify that the DSN exists.

If necessary, proceed to step 4 to add it.

To add aDSN, type 2 and press Enter.

At the prompts, type a database type, data source name, and adescription. You
may also be prompted for additional information depending on the RDBM S
platform of the DSN you are adding, such as servername, hostname, or
database name.

To verify addition of aDSN, type 1 and press Enter.
Verify that the DSN you just added isincluded in the list.
Type 5 and press Enter to exit the utility.

Note: You can delete DSNs by typing 3 at the starting odbcconf i g utility window.
Use the List option (1) to verify that the DSN has been deleted.

[J To test an ODBC connection using the odbcconfi g utility:

1.

Log in to the computer that runs Essbase Integration Server as the user who
starts the Essbase I ntegration Server software.

Start the odbcconf i g utility.
The utility lists the available options:. List, Add, Delete, Test, and Exit.
To test the ODBC connection, type 4 and press Enter.
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4. At the prompts, type a data source name, user name, and password.

If no errors are returned, the connection is valid.

In the event of errors, proceed to step 5 to add corrected DSN information.
5. ToaddaDSN, type 2 at the starting odbcconf i g utility window.

The odbcconfi g utility does not permit editing of DSN information. You
must add new DSN entries and delete any incorrect entries.

At the prompts, type a data source name, user 1D, and password.

6. Type1l and press Enter to list DSNs and verify that the DSN you just added
isincluded in thelist.

7. Type4 and press Enter to test the new ODBC connection.
If no errors are returned, the connection is valid.
8. Repeat the stepsin this section until the connection tests return no errors.

9. Type5 and press Enter to exit the utility.

[l Toinspect thelogin script files:

1. Log on tothe computer that runs Essbase I ntegration Server as the user who
starts the Essbase Integration Server software.

2. Inthe current home directory, find the main login script file (typicaly,
. profilefor Korn Shell and Bourne Shell users, . | ogi n for C Shell users)
and open it in atext editor.

Note: The primary login script file may be named differently, depending on the
UNIX operating system and the system administrator.

3. Check the main login script file for the inclusion of the Essbase Integration
Servicesscript (i s. sh ori s. csh).

If one of these scriptsisincluded in the main login script, make sure that the
inclusion of the script file name follows the syntax for executing a script file
within another script, and that the script file is specified with a complete
directory path. For more information, see “Correcting ODBC Problems” on

page 65.

Note: If you make a change to the login scripts, log out and then log back on to
reset the environment variables.
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4.

After completing the preceding steps, test the connection by following the
steps listed in “Testing the Essbase Integration Services Console Connection
to the RDBMS” on page 56.

If you cannot make a connection, proceed to “ Testing the Essbase Integration
Server Connection to the RDBMS’ on page 53.

[l Toinspecttheodbc. ini file

1.

Log on to the computer that runs Essbase | ntegration Server as the user who
starts the Essbase I ntegration Server software.

To determine the location of the odbc. i ni file, type
echo $ODBCI NI

If this command does not display afile name and directory location, then you
have not included the Essbase I ntegration Services script in thelogin script for
the user. For more information, see “ Correcting Essbase Integration Server
Problems” on page 67.

Move to the directory specified by $ODBCINI and open the odbc. i ni file
with atext editor.

Ensure that you are using the exact file name and directory that you have set.
For example, typevi $ODBCI NI to display the file name and path of the
$ODBCINI environment variable.

Check that the name of the data sources you are using with Essbase Integration
Services are listed in the ODBC Data Sources section; for example

[ ODBC Dat a Sour ces]
TBC_MD=Essbase Integration Serveices sanple catal og
TBC=Essbase Integration Services sanpl e database

For each data source, check that thereisa section starting with the name listed
in the ODBC Data Sources section, enclosed in brackets; for example

For Oracle;

[ myoracl e]
Driver=
/ horre/ hyperi on/ essi nt egrati on/ odbc/ merant 40/ 1 i b/ ARor 815. so
Descri ption=ny oracle source
Ser ver Nanme=nyt nsSer ver Name
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For DB2:

[ TBC_MD)
Driver =/ home/ db2i nst1/sqllib/lib/db2.so
Descri pti on=DB2 dat abase for sanple testing

6. Within the section for each data source, verify that an ODBC driver fileis
specified.
Make surethat thedriver file exists by exiting thetext editor and attempting to
get adirectory listing for that file; for example

I's /hone/ db2inst1/sqllib/lib/db2.so

If thefileislisted, usei vt est | i b to check the actua name and location of
the driver, then make the appropriate changesto the odbc. i ni file.

Tip: Copy the directory and file name for the driver from the odbc. i ni file and
paste it into an | s command.

7. Within the section for each data source, verify that the database name,
computer name, and other required information are specified.

For more information, see “Correcting ODBC Problems’ on page 65.

Testing the Essbase Integration Server Connection to the
RDBMS

After verifying the connections between the ODBC, the database client, and the
RDBMS, the next step in isolating a connection problem is to connect to the
RDBMS databases from Essbase I ntegration Server. Test this connection by
running Essbase Integration Services Shell on the same computer that runs
Essbase I ntegration Server. For more information on the use and syntax of Esshase
Integration Services Shell commands, see Chapter 5, “Using Essbase Integration
Services Shell.”

Note: The following procedure uses the sample OLAP Metadata Catalog and sample
database. For your tests, substitute the OLAP Metadata Catalog and data source
information you are using.
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Thistest usesthe LOADMEMBER command to test connections. When the
loadmember starts aload, it attempts to make connections in the following order:

1.
2.
3.

Data source, using ODBC
OLAP Metadata Catalog, using ODBC
Essbase server, using TCP/IP

In this test, you set up these connections one at atime and execute aloadmember
command each time. By examining the errors each time, you can determine which
connections are successful.

To test the Essbase I ntegration Server connection to the RDBMS:

1.

Verify that Essbase Integration Server is running.

If the server softwareisnot running, start the server. If the server will not start,
check that the Essbase Integration Services environment variables are set. For
more information, see “ Correcting Essbase Integration Server Problems” on

page 67.

On the same computer that is running Essbase Integration Server, start
Essbase | ntegration Services Shell at a command prompt by typing
ol api cnd

If Essbase Integration Services Shell does not start, make sure that the
software isinstalled and that the Essbase Integration Services environment
variables are set. For more information, see “ Correcting Essbase I ntegration
Server Problems’ on page 67.

At the Essbase Integration Services Shell command prompt, use the login
command to connect to the Essbase | ntegration Server computer; for example,

type
l ogin cypress
Check the release of Essbase Integration Services by typing

ver si on

Make surethat the version of the product you are using is compatible with the
ODBC drivers and the version of Essbase you are using. For information on
component compatibility, see the Essbase Integration Services Installation
Guide.
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5. Set the data source to the sample data source by typing
set sour ce "DSN=TBC; U D=TBC;, PMD=passwor d"

The DSN parameter requires the ODBC data source name, which may be
different from the database name in the RDBMS.

6. Test the connection to the data source database. Attempt to perform amember
load by typing
| oadrenber " APP=CLAP_TBC; DBN=Basi c; OTL=TBC Met aoutli ne;"

7. Check the status of the preceding command by typing

st at us

During amember |oad, Essbase | ntegration Services Shell connectsto the data
source first, then to OLAP Metadata Catal og. If the connection to the catalog
is unsuccessful, the message “1S Error: Unable to login to Catalog” is
displayed. If the connection to the data source fails, the message “1S Error:
Unableto login to Datasource” is displayed.

If the connection to the data sourcefailed, verify the ODBC data source name,
user name, and password. If the connection continuesto fail, see“ Correcting
Essbase Integration Server Problems’ on page 67 and “Correcting ODBC
Problems” on page 65. Repeat step 4 to step 6 of this procedure to retest the
connection. When you successfully connect to the data source, continueto the
next step.

8. Set OLAP Metadata Catal og to the sample OL AP Metadata Catal og by typing
set cat al og " DSN=TBC_MD; Ul D=TBC; P\D=passwor d"

The DSN parameter requires the ODBC data source name, which may be
different from the OL AP Metadata Catal og database name in the RDBMS.

9. Test the connection to the OLAP Metadata Catalog database. Attempt to
perform a member load by typing

| oadrmenber " APP=CLAP_TBC; DBN=Basi c; OTL=TBC Met aoutl i ne; "
10. Check the status of the preceding command by typing
st at us

During amember load, Essbase Integration Services Shell connectsto OLAP
Metadata Catalog and then to the Essbase server. If the connection to OLAP
Metadata Catalog is successful, the message “1S Error: Unableto login to
Essbase Server” is displayed. If the connection to OLAP Metadata Catal og
fails, the message “IS Error: Unableto login to Catalog” is displayed.
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If the connection to OLAP Metadata Catalog failed, verify the ODBC data
source name, user name, and password. If the connection continues to fail,
see “Correcting Essbase Integration Server Problems’ on page 67 and
“Correcting ODBC Problems” on page 65. Repeat step 7 to step 9 of this
procedure to retest the connection. When you successfully connect to OLAP
Metadata Catalog, continue to the next step.

11. Test theconnection from Essbase | ntegration Services Consoletothe RDBM S
by proceeding to “ Testing the Essbase Integration Services Console
Connection to the RDBMS” on page 56.

Testing the Essbase Integration Services Console
Connection to the RDBMS

After you have corrected problems with the components that enable Essbase
Integration Services Console to connect to the RDBMS, attempt a connection
from the console to an OL AP Metadata Catal og and a data source database

in the RDBM S to prove the corrections are successful. To isolate possible
computer-to-computer connection problems, run Essbase Integration Services
Console on adifferent computer than the one running Essbase I ntegration Server.

[] To test the Essbase Integration Services Console connection to the RDBMS:
1. Verify that Essbase Integration Server is running.

If the server softwareisnot running, start the server. If the server will not start,
check that the Essbase Integration Services environment variables are set. For
more information, see “ Correcting Essbase Integration Server Problems’ on

page 67.

2. Onacomputer other than the one running Essbase Integration Server, start
Essbase | ntegration Services Console.

3. Connect to the Essbase I ntegration Server computer and OLAP Metadata
Catalog; for example, cypressand TBC_MD.

If the connection fails, verify that you have specified the correct ODBC data
source namefor the OL AP M etadata Catal og database and the correct Essbase
Integration Server computer name. Also verify that you specified the correct
user name and password for the OLAP Metadata Catal og database on the
RDBMS. For moreinformation, see* Correcting Essbase I ntegration Services
Console Problems’ on page 68.
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4. After connecting to OLAP Metadata Catal og, open an OLAP model and
connect to the data source for the OLAP model.

If the connection fails, verify that you have specified the correct ODBC data
source name for the data source and the correct Essbase Integration Server
computer name. Also verify that you specified the correct user name and
password for the data source database on the RDBM S. For more information,
see “Correcting Essbase Integration Services Console Problems’ on page 68.

Testing the Essbase Integration Server Connection to
Essbase OLAP Server

When isolating connection problems between Essbase I ntegration Server and
Essbase OLAP Server, use Essbase I ntegration Services Shell to establish a
connection to a data source and OL AP Metadata Catal og, and then attempt to
load members into an Essbase database.

[l To test the Esshase Integration Server connection to an Essbase OLAP Server:
1. Verify that Essbase Integration Server is running.

If the server softwareisnot running, start the server. If the server will not start,
check to ensure that the Essbase Integration Services environment variables
are set. For more information, see “ Correcting Essbase Integration Server
Problems” on page 67.

2. Verify that the Essbase OLAP Server is running.
3. Atacommand prompt, start Essbase Integration Services Shell by typing
ol api cnd

If Essbase Integration Services Shell does not start, make sure that the
software isinstalled and that the Essbase I ntegration Services environment
variables are set. For more information, see “ Correcting Essbase Integration
Server Problems’ on page 67.

4. At the Essbhase Integration Services Shell command prompt, use the login
command to connect to Essbase I ntegration Server; for example, type

I ogi n cypress
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5. Set the data source to the sample data source by typing
set sour ce "DSN=TBC; U D=TBC;, PMD=passwor d"

The DSN parameter requires the ODBC data source name, which may be
different from the database name in the RDBMS.

6. Set OLAP Metadata Catalog to the sample OLAP Metadata Catal og by typing
set cat al og " DSN=TBC_MD; Ul D=TBC; P\D=passwor d"

The DSN parameter requires the ODBC data source name, which may be
different from the OL AP Metadata Catal og database name in the RDBMS.

7. Set the Essbase OLAP Server to which you want to connect by typing
settarget "DSN=sequoi a; U D=TBC; PMD=passwor d; "

Note: If you are using Essbase Integration Services Console on a client computer
that is outside the firewall for your network, and you require access to an Essbase
Integration Server and Essbase OLAP Server located inside the firewall for your
network, be sure to use a name or an IP address for the OLAP Server that is
accessible from both sides of the firewall.

8. Test the connection to the Essbhase OLAP Server by attempting to perform a
member |oad by typing

| oadrenber " APP=CLAP_TBC; DBN=Basi c; OTL=TBC Met aout| i ne; "
9. Check the status of the preceding command by typing
st at us

If the connection failed, the message ISError: Unableto login to Essbase
Server isdisplayed. Make sure that the Essbase OLAP Server is running.
Verify the name of the metaoutlinein Essbase. Also verify the name of thetest
application and database in Essbase. Repeat step 7 to step 8 of this procedure
to retest the connection.

After you can connect successfully to the Essbase OLAP Server, proceed to
“Testing the Essbase I ntegration Services Console Connection to Esshase
OLAP Server” on page 59.
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Testing the Essbase Integration Services Console
Connection to Essbase OLAP Server
When isolating the connection problems between Essbase I ntegration Services

Consoleand Essbase OL AP Server, connect to OLAP Metadata Catal og and adata
source, and then attempt to load members into an Essbase database.

Note: The following procedure uses the sample application, including the sample
database, OLAP Metadata Catalog, OLAP model, and metaoutline. For your tests,
substitute the application and databases you are using.

[1 To test the Esshase Integration Services Console connection to an Essbase OLAP
Server:

1.
2.
3.
4.,

Verify that Essbase Integration Server is running.
Verify that Essbase OLAP Server is running.
Start Esshase Integration Services Console.

From Essbase | ntegration Services Console, connect to the Essbase
Integration Server computer and OLAP Metadata Catal og; for example,
cypressand TBC_MD.

After connecting to OLAP Metadata Catal og, open ametaoutline and connect
to the data source for the metaoutline; for example, TBC Metaoutline and
TBC.

Start amember load by selecting Outline > Member L oad.

If prompted, provide the name of the Essbase OLAP Server, user name, and
password.

If the Essbase Application and Database dialog box is displayed, the
connection issuccessful. If the connection failed, verify that you have entered
the correct computer name for the Essbase OLAP Server and the correct user
name and password. For more information, see the Essbase documentation.

If the Esshase OLAP Server islocated on alarge network, you may need to
provide amore specific server name address, such as*“ cypress.hyperion.com”
rather than simply “cypress.”

Note: If you are using Essbase Integration Services Console on a client computer
that is outside the firewall for your network, and you require access to an Essbase
Integration Server and Essbase OLAP Server located inside the firewall for your
network, be sure to use a name or an IP address for the OLAP Server that is
accessible from both sides of the firewall.
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Correcting Connection Problems

In correcting connection prablems with Essbase Integration Services, consider
both component-level and system-level problems. The following topics list
possible problems and areas for investigation within the software components that
comprise a Essbase | ntegration Services system.

To correct system-level problems which can occur across software components,
review the following issues:
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Are all user names and passwords being used consistently across all the
components and computer user accounts? For more information, see “User
Name and Password Problems” on page 61.

Do dl of the user accounts used in the system have the appropriate
permissions and privileges?

System administratorstypically use highly privileged administrative accounts
when setting up and testing a system. After the system is set up, users with
fewer privileges may be unable to use the system successfully. Check
permissions on the following components:

— User account on the client computer

—  User account on the server computer

— OLAP Metadata Catalog database

— Datasource database

—  User account for the Essbase OLAP Server

Are the software components using adequate addressing to identify the
computers to which they are connecting?

Depending on the size and configuration of the computer network, it may be
necessary to use a fully-qualified host address to connect to a particular
computer. For example, instead of the host name “ cypress,” the complete host
name “ cypress.mydivision.mycompany.com” may be required. Alternatively,
you might need to use the IP address number for the server computer; for
example, 127.0.0.1.
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« Isthe user who starts Esshase Integration Server (for example, hyperion)
configured to run all the required software?

The user (for example, hyperion) must have all required environment
variables set and permissionsto run all of the following software components:

— Essbase Integration Server
— ODBC software
— Database client software

— RDBMS server (this may not be required)

User Name and Password Problems

Consistent use of user names and passwords is often a problem in installing,
configuring, and using Essbase I ntegration Services, because of the numerous
software components and computers that make up the system.

Tip: During installation, configuration, and testing, keep a list of all the user names and
passwords you use to create or modify the system, including the applications with which
they are associated and their purpose.

Inasmaller, single-server implementation of Essbase Integration Services, where
Essbase Integration Server, Essbase OLAP Server, and the RDBMS areall run on
asingle computer, you must manage five user name and password sets and use
them consistently:

«  User account on the Essbase I ntegration Services client computer
«  User account on the computer that runs all of the server software
« OLAP Metadata Catalog database in the RDBM S

« Datasource database in the RDBM S

o Esshase server software

In afully distributed, three-server implementation, where Essbase I ntegration
Server, Esshbase OLAP Server, and the RDBM S are all run on separate computers,
you must manage seven user name and password sets and use them consistently:

«  User account on the Essbase I ntegration Services client computer
« User account on the computer that runs Essbase I ntegration Server

«  User account on the computer that runs the RDBMS
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OLAP Metadata Catalog database in the RDBM S
Data source database in the RDBM S
User account on the computer that runs Essbase OLAP Server

Essbase server software

Adding aliases or synonymsto the RDBM S databases adds to the number of user
name and password sets you must manage. For more information about database
user aliases and synonyms, see the Essbase Integration Services I nstallation
Guide.

Tip: During installation and connection testing, use a single set of user names and
passwords to avoid confusion. Add user aliases or synonyms after the system is
configured and running.

Correcting RDBMS Problems

To correct problems connecting to the RDBMS, investigate the following possible
CaUSes:

Isthe RDBMS server computer and software running? Has the server locked
up, stopped, or failed?

Isthe RDBMS software installed? Are all of the components required for
ODBC connectionsinstalled?

Some RDBM Ss may require additional software components beyond the
basic server software to enable ODBC connections. The database client
software is usually required on the computer that connects to the RDBM S
server using ODBC and also may be required on the RDBM S server computer.

Do the OLAP Metadata Catal og and data source databases to which you are
trying to connect exist? Have the tables for OLAP Metadata Catalog been
created?

You can create the OLAP Metadata Catal og tables either automatically or by
using the creation scripts provided with Essbase Integration Services. For
more information, see the Essbase Integration Services Installation Guide.

What are the exact names of the OL AP Metadata Catalog and data source
databases? Are the names case-sensitive?
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« Doesthe user name that you are using to connect to the RDBMS have
adequate permissions to access the database? Does the user have read and
write permissions?

For the OLAP Metadata Catalog database, users need full read and write
permissions. For the data source database, users need read-only permissions.

« EssbaseIntegration Serverlf the RDBM S server ison acomputer by itself, is
thereacorresponding user account on the computer for the user namesyou are
using to connect to the databases?

To allow connections to the database server from other computers, you may
need to set up user accounts on the RDBMS server computer, separate from
the database users you create.

« Doesthe RDBMS require any addressing beyond the name of the database if
you are using the database client software or ODBC to connect?

Some RDBM Ss may have specific naming requirements for connecting to
their databases, including different naming conventions for third-party
applications (such as Essbase I ntegration Services). For more information,
see the documentation for the RDBMS.

Correcting Database Client Problems

If you have prablems connecting to the RDBM S from the database client software,
investigate the following possible causes:

« Isthe database client software installed? Are al database client components
required for the ODBC connections installed?

To enable ODBC connections, some database client software may require
additional software components beyond the basic server software. The
database client software usually is required on the computer that uses ODBC
to connect to the RDBMS server and may also be required on the RDBM S
server computer.

« Isthe database client software compatible with the RDBM S?

Newer or older versions of the database client software may not work with the
RDBMS version you are running. For more information, see the RDBM S
documentation.
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« Do the database client software utilities, such as the command-line SQL
interface, start? Do they start when you are logged on as the user who runs
Essbase I ntegration Server?

When you run the database client software, the user account must have the
appropriate file access permissions and must have set the path and other
environment variables. Verify that the user who runs Essbase I ntegration
Server (typically, hyperion) is configured to run the database client software.

On UNIX systems, ascript fileisusually provided by the RDBM S vendor to
set the required environment variables and should beincluded in the main user
login script. If youinclude one of thesefilesinthe mainlogin script, make sure
that you specify a complete directory path and that you follow the syntax for
executing a script file within a script.

« Arethe RDBMS server names, database names, user names, and passwords
specified correctly?

Make sure you are using the correct names, including the exact spelling,
uppercase or lowercase letters, and any required RDBM S-specific
identification syntax. For more information about correcting user name
and password problems, see “ Correcting RDBM S Problems” on page 62.

« Isthe database client software configured correctly?

File access permissions, path, and other environment variables must be set for
the user who runsthe database client software. Additional configuration steps
also may be required for specific database clients.

For more information on configuring database client software, see the
install ation documentation for the database client software.

DB2: You may be required to bind the database client software utilities
to the DB2 databases. For more information, see the DB2 installation
documentation.

Oracle: The database name for Oracle databases can be specified in a
t nsnanes. or a file, which must be configured by the database administrator.
For more information, see the Oracle installation documentation.
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Informix: Ensure that the sgl host s environment variable is properly set.

Inthesql host s file, you must specify a TCP protocol for your operating
system as follows:

—  Windows NT, AlX, and HP-UX: onsoctcp
— Solaris: ontlitcp

Sybase: Usethe dsedit utility (type $SYBASE/ bi n/ dsedi t ) to view and edit
server entries.

Note: MERANT Version 4.0 ODBC drivers are 32 bit. To connect the database client to
Essbase Integration Server using MERANT ODBC drivers, the database client software
that you use must be 32 bit.

Correcting ODBC Problems

To correct problems connecting to the RDBMS using ODBC, investigate the
following possible causes:

« Isthe ODBC software installed? Are all of the required ODBC components
installed?

On Windows systems, make sure the ODBC core components and any
required drivers areinstalled. On UNIX systems, the Essbase Integration
Services setup program installs the required ODBC core components if you
chooseto install the MERANT ODBC drivers.

« Isthe ODBC driver compatible with the RDBMS? Is the driver compatible
with the operating system?

Verify that the ODBC driver you are using is supported by Essbase Integration
Services by referring to the compatibility matrix provided in the Essbase
Integration Services Installation Guide.

« Arethe RDBMS server names, database names, user names, and passwords
specified correctly in the ODBC data source?

Make sure you are using the correct names, including the exact spelling,
uppercase or lowercase letters, and any required RDBM S-specific
identification syntax. On Windows systems, configure ODBC data sources by
using ODBC Administrator. On UNIX systems, configure ODBC datasources
either by using the odbcconf i g utility or by editing the odbc. i ni file
manually.
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DB2: On Windows systems, the DB2 Client Configuation Assistant showsthe
ODBC DSN.

For more information about correcting user name and password problems,
see “Correcting RDBM S Problems” on page 62.

« OnUNIX systems, have you specified thefull path and file name of the ODBC
driver for the data source in the odbc. i ni file? Doesthe ODBC driver
actually exist in the specified directory? Cani vt est | i b load it?

Try copying the driver path and file namefrom theodbc. i ni fileand pasting
itinto anlscommand. If thefileis not listed when you execute the command,
check the accuracy of the driver path and file namein the odbc. i ni file.

« Areany parameters missing in the ODBC data source configuration?

On Windows systems, make sure you havefilledin all required parametersfor
the data source in ODBC Administrator. On UNIX systems, the Essbase
Integration Servicesinstallation providesasampleodbc. i ni file, which may
not include data source parameters required for the RDBMS that you are
using. For more information on required RDBM S-specific ODBC driver
parameters, see the ODBC documentation provided with Essbase Integration
Services in Adobe Portable Document Format (PDF) in the

| SHOME/ odbc/ mer ant 40/ docs directory. For examples of odbc. i ni file
configurations for the supported RDBM S platforms, see the Essbase
Integration Services Installation Guide.

« Can other applications connect to the RDBMS by using ODBC?

If you can identify another application that is successfully using ODBC
to connect to databases on the RDBMS, analyze the configuration of the
computer from which the connection is made and use it as a model for the
computer connections you are trying to fix.

Note: Most RDBMS vendors provide utilities to test ODBC connections. For
information, see the documentation for the RDBMS.

If the preceding checks do not enable you to correct the problems connecting from
ODBC to the RDBMS, try using ODBC tracing to isolate the problem. For more
information, see“Using ODBC Tracing” on page 70.
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Correcting Essbase Integration Server Problems

To correct problems connecting to the RDBM S from Essbase I ntegration Server,
investigate the following possible causes:

« |sEsshase Integration Server installed? Are all the required Essbase
Integration Server components installed?

The following components must be installed to have afunctional Essbase
Integration Server:

— Essbase Integration Server software.

— Related base components. (On UNIX, these components are included as
part of Essbase Integration Server software.)

— MERANT ODBC drivers (unless ODBC and drivers are already
installed).

« IsEsshase Integration Server running? Isit configured properly?

Start Essbase Integration Server by opening acommand prompt window and
typing ol api svr.

If Essbase Integration Server does not start, review the following possible
problems:;

— Aretherequired environment variables set? Are they set for the correct
user name?

On Windows systems, if you decide not to let the setup program
automatically update the environment variables, you must update
them manually.

On UNIX systems, ascript file(i s. sh ori s. csh) that setsthese

variables must be included in the login script of the user who starts
Essbase | ntegration Server. For more information, see the Essbase
Integration Services Installation Guide.

— What version of Essbaseisinstalled?

If an incompatible version of Essbase isinstalled on the same computer
as Esshase I ntegration Server and the\ essbase\ bi n directory isin the
current path, Essbase | ntegration Server doesnot start. For information on
compatible versions of Esshase, see the Essbase Integration Services
Installation Guide.
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— Isport 3388 in use?

Essbase | ntegration Server uses port 3388 to communicate with the
Essbase | ntegration Services client software. If this port is being used
by another program, the server software does not start.

— OnUNIX, is more than one copy of ol api svr running? If so, all
servers except one will hang indefinitely. To correct the problem, run the
following command to display all programs that are currently running:
ps -fe | grep ol api svr

Many of the problems related to Essbase I ntegration Server not working properly
may be traced to manual configuration steps that you may have missed. For more
information about manual configuration steps, see the Essbase Integration
Services Installation Guide.

Correcting Essbase Integration Services Console
Problems

If you have problems connecting to the RDBM Sfrom Essbase I ntegration Services
Console and have ruled out problems with the RDBMS, database client, ODBC,
and Esshase Integration Server, the problem likely originates in the Essbase
Integration Services Console component.

To correct problems connecting to the RDBM S from the console, investigate the
following possible causes:

I's Esshase Integration Services Console installed? Are al of the required
components installed?

The following components must be installed to have afunctional Essbase
Integration Services Console client:

— Essbase Integration Services Console software
— Related base components
I's the Essbase Integration Services Console configured properly?

Make suretherequired environment variables are set. If you decide not to have
the setup program update the environment variables, you must update them
manually. For more information about manual configuration of variables, see
the Essbase Integration Services Installation Guide.
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Arethe Essbase | ntegration Server computer name, ODBC data source names,
user names, and passwords specified correctly?

For the Essbase Integration Server computer name, verify that you are using

the correct spelling and uppercase and lowercase letters for the server name.

For OLAP Metadata Catalog and the data source, make sure you are using an
ODBC data source name, which may be different from the RDBM S database
name.

Note: The user names and passwords for the OLAP Metadata Catalog database
may be different from the data source. Verify that you are using the correct login
information for each database.

For moreinformation about correcting user name and password problems, see
“Correcting RDBMS Problems” on page 62.

Does the user account with which you are running Essbase I ntegration
Services Console have permission to connect to the computer running Essbase
Integration Server?

You must haveauser account and appropriate access permissionson the server
computer running Essbase Integration Server.

If you have Essbase Integration Server installed on more than one compulter,
have you specified the correct server name?

A particular Essbase Integration Server may not be set up to access the same
OLAP Metadata Catalogs and data sources used by other servers.

Are you using adequate addressing to identify the Essbase Integration Server
computer?

Depending on the size and configuration of the computer network, it may be
necessary to use a fully-qualified host address to connect to a particular
computer. For example, instead of the host name * cypress,” the complete host
name “ cypress.mydivision.mycompany.com” may be required. Alternatively,
you might need to use the IP address number for the server computer; for
example, 127.0.0.1.
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Using ODBC Tracing

If you do not have accessto ODBC testing utilities or third-party applications that
use ODBC, tracking down ODBC problems can be difficult. Using the tracing
utility provided with ODBC can help identify and resolve connection problems.

Using ODBC Tracing on Windows Systems

On Windows systems, if you cannot connect to the relational data sourceor OLAP
Metadata Catalog, use the tracing utility in ODBC Administrator to learn which
ODBC cdl isfailing.

[1 To usethetracing utility in ODBC Administrator:

1.
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Start ODBC Administrator on the computer running Essbase Integration
Server.

Click the Tracing tab, specify alogfilefor thetracing utility, then click Start
Tracing Now.

Note: Tracing quickly creates a large log file. Disable tracing when you are
finished: On the Tracing tab, click Stop Tracing Now.

Start Essbase Integration Server and Essbase Integration Services Console.

From Essbase | ntegration Services Console, select Connections > OLAP
M etadata Catalog > Connect, and try to connect to OL AP M etadata Catal og.

If you can connect to OLAP Metadata Catalog, open an OLAP model and try
to connect to arelational data source.

If either connection fails, see the file you specified as the log file in the root
directory.

If necessary, share the information in thislog file with Hyperion Technical
Support to help solve the connectivity problem.
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Using ODBC Tracing on UNIX Systems

On UNIX systems, if you cannot connect to the relational data source or OLAP
Metadata Catal og, use the tracing to learn which ODBC call isfailing. On UNIX
systems, you must edit the odbc. i ni file to enable and disable ODBC tracing.

[l Touse ODBC tracing on UNIX systems:

1.

On the computer running Essbase | ntegration Server, opentheodbc. i ni file
by using atext editor such asvi.

Find the section starting with [ODBC], as shown in the following example:

[ oDBC

Trace=0

TraceFi | e=odbct race. out

TraceDl | =/ export/ hone/ user s/ hyperion/is/odbclib/odbctrac. so
I nstall Dir=/export/hone/users/hyperion/is/odbclib

Set the Trace setting to 1 to enable ODBC tracing.

Note: Tracing quickly creates a large log file. Disable tracing when you are finished
by setting the Trace parameter to O.

Start Essbase Integration Server and Essbhase Integration Services Console.

From Essbase | ntegration Services Console, select Connections > OLAP
M etadata Catalog > Connect, and try to connect to OL AP M etadata Catal og.

If you can connect to OLAP Metadata Catal og, open an OLAP model and try
to connect to arelational data source.

If either connection fails, read the odbct r ace. out file.

If necessary, share the information in thislog file with Hyperion Technical
Support to help solve the connectivity problem.
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cicncs - Tables in OLAP Metadata

4 Catalog

OLAP Metadata Catalog is a relational database that contains OLAP models,
metaoutlines, and the information necessary to retrieve the required data from
the relational data source. You can install OLAP Metadata Catalog in any
supported data source. See the Essbase I ntegration Services Installation Guide
for acomplete list of supported data sources.

This chapter describes the tablesin OLAP Metadata Catalog. It contains the
following topics:

« “About OLAP Metadata Catalog” on page 74

« “Tables Relating to the OLAP Model” on page 75
« “Tables Relating to the Metaoutline” on page 77

. “Tables Relating to Drill-Through” on page 80

« “Tables Relating to Hybrid Analysis’ on page 81
« “Miscellaneous Tables’ on page 82
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About OLAP Metadata Catalog

OLAP Metadata Catal og contains acollection of related tables. Thetables provide
aplacefor you to store OL AP models and metaoutlines. When you load members
or datainto an Esshase database, Essbase I ntegration Services retrieves the
information stored in OLAP Metadata Catalog to determine:

« What datato retrieve from the relational data source
« What operations to perform on the data
« How to load the data into the Esshase database

CAUTION: ltis strongly recommended that you do not alter the table
names or data in OLAP Metadata Catalog with tools other than Essbase
Integration Services.

Regularly back up the database that contains OLAP M etadata Catal og so that you
can restore OLAP Metadata Catalog from backupsiif it becomes corrupted. Use
one of the proceduresin Table 2, depending on what OLAP Metadata Catal og
component you want to restore.

Table 2: OLAP Metadata Catalog Restore Procedures

Component To Restore Procedure

OLAP Metadata Catalog as you Run a script to create the database
installed it, without any OLAP models | tables. See the Essbase Integration
or metaoutlines that you might have Services Installation Guide.
created

OLAP Metadata Catalog, including the | Restore the database that contains
OLAP models and metaoutlines that OLAP Metadata Catal og from backups.
you have created See the documentation for the relational
data source.
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Tables Relating to the OLAP Model

Table 3 describes each table in OLAP Metadata Catal og that stores information
about OLAP models. For information about the other tablesin OLAP Metadata

Catalog, see:

« “Tables Relating to the Metaoutling” on page 77

. “Tables Relating to Drill-Through” on page 80
. “TablesRelating to Hybrid Analysis’ on page 81

o “Miscellaneous Tables” on page 82

Table 3: OLAP Model Tables

Table Name

Description

MB_FILTER

Contains information about filtersin the OLAP model.
This information includes the hierarchy filter and
system-generated |D numbers for parts of the OLAP
model.

MB_TX_RULE

Contains information about hierarchiesin the OLAP
model. Thisinformation includes transformations to
perform on the hierarchy and system-generated ID
numbers for parts of the OLAP model.

OA_INFO

Containsinformation about columnsin adimension table
or afact table. Thisinformation includes the column
name, the column data type, the OLAP model it belongs
to, the dimension or fact table it belongs to, the source
table and column on which it is based, whether it is
hidden in OLAP models and metaoutlines, whether it is
used for Drill-Through, whether it is enabled for
attributes, and how to create it if it is a user-defined
column.

OD_DETAILS

Containsinformation about dimensions in the OLAP
model. Thisinformation includes system-generated |D
numbers for parts of the OLAP model.
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Table 3: OLAP Model Tables (Continued)

Table Name Description

OD_INFO Contains information about dimensions in the OLAP
model. Thisinformation includes the dimension name,
the OLAP model the dimension belongs to, and whether
the dimension is a measures dimension.

OM_INFO Contains high-level information about an OLAP model:

the name of the OLAP model, the description, the name
of the data source on which the OLAP model is based,
the owner, and access privileges.

OM_PROPERTIES

Contains property information for the OLAP model.

OMB_DETAILS

Contains information about hierarchiesin the OLAP
model. Thisinformation includes the position of each
column in the hierarchy, the order in which to build the
hierarchy, and system-generated |D numbers for parts of
the OLAP model.

OMB_INFO

Contains information about hierarchiesin the OLAP
model. Thisinformation includesthe hierarchy name, the
OLAP model that it belongs to, and the dimension to
which it belongs.

OV_INFO

Contains information about the dimension tables and the
fact table in an OLAP model. Thisinformation includes
the dimension or fact table name, the OLAP moddl it
belongs to, its position in the right frame of the OLAP
Model main window, and whether it isa dimension table
or afact table.

OVL_REL_DETAILS

Containsinformation about logical joins between
dimension tables and fact tables. Thisinformation
includes the name of the first column and the name
of the column to which the first column is joined.

OVL_REL_INFO

Containsinformation about logical joins between
dimension tables and fact tables. Thisinformation
includes the name of the first dimension or fact table and
the name of the dimension or fact table to which the first
dimension is joined.
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Table 3: OLAP Model Tables (Continued)

Table Name

Description

OVP_REL_DETAILS

Contains information about physical joinsin the source
tables. This information includes the name of thefirst
source column and the name of the source column to
which the first source column is joined.

OVP_REL_INFO

Contains information about physical joins in the source
tables. This information includes the name of thefirst
source table and the name of the source table to which
the first source tableisjoined.

OM_DESCRIPTIONSs

Contains descriptions for amodel, its dimensions, its
members, and its hierarchies. Thisinformation includes
the system-generated ID number for each model,
dimension, member, or hierarchy that is described.

JOIN_HINTS

Contains information about the database hints defined
for ajoin. Thisinformation includes the type of jain, the
physical tableto join, and the text of the join hint.

Tables Relating to the Metaoutline

Table 4 describes each table in OLAP Metadata Catal og that stores information
about metaoutlines. For information about the other tablesin OLAP Metadata

Catalog, see:

« “Tables Relating to the OLAP Model” on page 75
« “Tables Relating to Drill-Through” on page 80
« “Tables Relating to Hybrid Analysis’ on page 81

« “Miscellaneous Tables’” on page 82
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Table 4: Metaoutline Tables

Table Name Description

MO _FILTERS Contains information about metaoutline filters. This
information includes the filter name and the actions the
filter will perform.

MO_INFO Contains high-level information about a metaoutline:
the name of the metaoutline, its description, the date

it was last changed, the OLAP model on which the
metaoutlineisbased, its owner, its access privileges, and
whether the spreadsheet user of Drill-Through reports
must enter the Essbase Integration Server name and a
user name and password for the external data source.

MO_PROPERTIES Containsinformation about metaoutline properties. This
information includes the name and value of metaoutline
properties, the name of the source table and column
that Essbase Integration Services uses to assign the
properties, the numeric range that represents arange
specified by the user, Global Settings properties, and
sort order.

Sort order is based on acolumn in the relational data
source, including columns not present in the OLAP
model or metaoutline. Sort order can be ascending or
descending.

Also contains information on association of attributes
(by level or by name) to base dimensions.

MOD_ATTRIBUTES Contains information about attribute dimensions,
such as attribute dimension type, alias names, and
transformation rules.

MOD_INFO Contains information about dimensionsin a
metaoutline. This information includes the dimension
name, the OLAP dimension with which it is associated
(unlessit is a user-defined dimension), the type of
dimension (a user-defined dimension, a measures
dimension, a standard dimension, or an attribute
dimension), and how members are positioned within
the dimension.
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Table 4: Metaoutline Tables (Continued)

Table Name

Description

MS_INFO

Contains information about members in a metaoutline.
Thisinformation includes the name of the member,

the dimension to which it belongs, whether it isa
user-defined member or a standard member, the OLAP
table with which it is associated, the OL AP model
column with which it is associated, the name of its
parent, how it is positioned with its siblings, and the
database measure with which it is associated (if itisa
user-defined member).

MS_PREDICATES

Contains information about members in a metaoutline.
This information includes member filters.

MS TX _RULE Contains information about members in a metaoutline.
Thisinformation includes member transformation rules.
MSR_INFO Contains information about database measuresin a

metaoutline. This information includes the name of the
measure, the OLAP model table with whichiitis
associated, the OLAP model column with whichitis
associated, and how it is positioned with its siblings.

MSR_PREDICATES

Contains information about database measuresin a
metaoutline. Thisinformation includes measure filters.

MSR_TX_RULE

Contains information about database measuresin a
metaoutline. Thisinformation includes the name and
definition of measure transformation rules.

MO_DESCRIPTIONS

Contains descriptions for a metaoutline, itsfilters, its
dimensions, and its members. This information includes
the system-generated |D number for each metaoutline,
filter, dimension, or member that is described.
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Tables Relating to Drill-Through

Drill-through reports are created in the OL AP Metaoutline main window of the
Essbase | ntegration Services Console (refer to online help for information on
creating drill-through reports). These reports enable Essbase Spreadsheet Add-in
usersto view datain the relational database that is not stored in the Essbase
database.

Table 5 describes each table in OLAP Metadata Catal og that stores information
about drill-through reports. For information about the other tablesin OLAP
Metadata Catalog, see:

. “TablesRelating to the OLAP Model” on page 75
“Tables Relating to the Metaoutling” on page 77

« “Tables Relating to Hybrid Analysis’ on page 81

« “Miscelaneous Tables’” on page 82

Table 5: Drill-Through Tables

Table Name Description

DTR_ATTRIBUTES Contains information about drill-through columns.
This information includes the order in which Essbase
Spreadsheet Add-in sorts and displays drill-through
information.

DTR_INFO Contains information about drill-through columns.
This information includes the name of the drill-through
column, whether the spreadsheet wizard is displayed,
and the time or row query governor specified.

MO_INTERSECTION | Contains information about drill-through columns.
This information includes system-generated ID
numbersfor the OLAP model, the drill-through column,
and the intersection level on which the columnis
defined.

MO_PROPERTIES Contains information about drill-through filters.
Thisinformation includes the Essbase user name and
password, drill-through report name, and metaoutline
name.
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Tables Relating to Hybrid Analysis

You enable Hybrid Analysisin the OL AP Metaoutline main window of the
Essbase | ntegration Services Console (refer to online help for information on
enabling Hybrid Analysis). Hybrid Analysisenablesyouto accesslower-level data
stored in arelational database. Thisrelationally stored data, although not
physically loaded into Essbase, is mapped to the appropriate Essbase hierarchies
and is available to Esshase Spreadsheet Add-in users. Unlike drill-through data,
which is displayed on a separate worksheet, Hybrid Analysis datais displayed
seamlessly on the current worksheet in Spreadsheet Add-in reports.

Table 6 describes the table in OLAP Metadata Catalog that stores information
about Hybrid Analysis. For information about the other tablesin OLAP Metadata
Catalog, see:

« “Tables Relating to the OLAP Model” on page 75
« “Tables Relating to the Metaoutling” on page 77

« “Tables Relating to Drill-Through” on page 80

« “Miscelaneous Tables’” on page 82

Table 6: Hybrid Analysis Tables

Table Name Description

MO_PROPERTIES Contains information about Hybrid Analysis columns.
This information includes system-generated |D numbers
for the OLAP model; the Hybrid Analysis column; and
column precision, scale, and nullability.
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Miscellaneous Tables
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Table 7 describes tables in OLAP Metadata Catal og that store miscellaneous
information about OLAP models and metaoutlines and about Essbase Integration
Services. For information about the other tablesin OLAP Metadata Catalog, see:

« “Tables Relating to the OLAP Model” on page 75
. “Tables Relating to the Metaoutline” on page 77

. “Tables Relating to Drill-Through” on page 80

o “Miscellaneous Tables” on page 82

Table 7: Miscellaneous Tables

Table Name Description

CB_CONCURRENCY | Contains information about users accessing an OLAP
model or metaoutline. This information includes the
user name, the user session 1D, the OLAP model or
metaoutline that the user is accessing, whether the user
isaccessing an OLAP model or a metaoutline, whether
the user has aread or read/write lock, and the date and
time the user acquired the lock.

CB_VERSION Contains information about the Essbase Integration
Services software you have installed. Thisinformation
includes the rel ease number of Essbase Integration
Services.
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This chapter describes the commands supported by Essbase Integration Services
Shell, the command-line tool provided with Essbase Integration Services. The
majority of these commands provide the same functionality available through
Essbase | ntegration Services Console. You use Essbase I ntegration Services Shell
commands and scripts to create Essbase outlines and load Essbase databases.

If you schedule member or dataloads using Essbase | ntegration Services Console,
Essbase I ntegration Servicesautomatically creates an Essbase | ntegration Services
Shell batch file and a corresponding . cbs file in the Bat ch directory. You can
modify and reuse the. cbs file for future member and data loads.

This chapter contains the following topics:

“ Starting Essbase I ntegration Services Shell” on page 84
“About Essbase Integration Services Shell” on page 85
“Using Essbase Integration Services Shell Commands” on page 91

“Loading Dimensions and Members Using Essbase I ntegration Services
Shell” on page 106

“Loading Data Using Essbase Integration Services Shell” on page 107

For alist of al available Esshbase I ntegration Services Shell commands, see* Using
Essbase Integration Services Shell Commands’ on page 91.
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Starting Essbase Integration Services Shell

Before you start Essbase Integration Services Shell, make sure that the following
programs are running. These programs can be on network server computersand do
not need to be on your local computer to be available to Essbase Integration
Services Shell:

84 m

A relational database management system (RDBMS) with the relational
database that contains the OL AP Metadata Catal og where the metadatais
stored

One or more RDBM Ss that contain the relational data sources that you want
to use to create OL AP models and metaoutlines

Essbase | ntegration Server
For more information, see“ Starting Essbase Integration Server” on page 16.
Essbase OLAP Server

For more information, see the Essbase Integration Services Installation
Guide.

L] To start Esshase Integration Services Shell, use one of the following methods:

From the Windows Start menu, select Programs > Hyperion Solutions >
Essbase | ntegration Services > Essbase | ntegration Services Shell.

Enter the executable name on the command line; for example, type
ol api cnd

To set the TCP port number with which Essbase Integration Server
communicates with its clients to a port different from the default 3388, enter
the executable name and -Pportnumber when you start Essbase Integration
Services Shell; for example, type

ol api cnd: 3390
Note: If Essbase Integration Services Shell does not start when ol api cnd is
executed from the command line, the operating system path may not be updated

correctly. For more information, see the Essbase Integration Services Installation
Guide.

Essbase Integration Services System Administrator's Guide



Using Essbase Integration Services Shell

The Essbase Integration Services Shell window opens, as shown in Figure 2:
Figure 2: Essbase Integration Services Shell Window

Essbase Integration Services Shell M= 3

Ezshase Integration Services Shell — 6.5.1 (Build I651B187>
Copyright{c)> 1998-2882 Hyperion Solutions Corporation
All rights reserved

[LOCALT —> _

In the Essbase Integration Services Shell window, enter commands at the
command prompt. For example, type the following commands:

« Typel ogi n nachi ne_nane tolog on to a server running on the same
machine.

o Typeshut down to stop the server.
. Typeexit to stop Essbase Integration Services Shell.
. Typehel p to get alist of Essbase Integration Services Shell commands.

About Essbase Integration Services Shell

Essbase | ntegration Services Shell is acommand-line tool that enables you to

access Essbase I ntegration Server to perform operations on an Essbase outline and
the data in an Essbase database.

With Essbase Integration Services Shell, you can perform server operations at the
command line in either batch or interactive mode.

. Batch mode. To automate routine server maintenance and diagnostic tasks,
write a script or batch file and run it from the command line.

Batch mode is convenient if you use a particular series of commands
frequently or if the task requires many commands.
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« Interactive mode. To perform tasks interactively, enter OLAP commands at
the command line.

Interactive mode is convenient for short operations that require few
commands, such as checking for information on the fly and error checking.

Tip: It can be difficult to enter commands correctly when using the command line. The
easiest method is to use the Essbase Integration Services Console OLAP Metaoutline
standard user interface to perform a data or member load, and then choose to create
a script file. You can then edit the script file as needed. Run all the commands in a
script file by redirecting the standard input to use your command file. For example,

ol api cmd<nycnd. cbs, or see “Running OLAP Command Script Files” on page 89.

Using SET and LOAD Commands

SET commandstell Essbase Integration Server which datasourcesareinvolvedin
aload operation. LOAD commandstell Essbase Integration Server to execute a
load operation.

Note: To perform a successful member and data load, the SET commands must be
executed before the LOAD commands.

SET commands provide Essbase | ntegration Server with the location of the source
databases, Essbase server, and OLAP Metadata Catalog. The commands can be
issued in any order, but you must issue all three SET commands before executing
aLOAD command.

Use SET commands as follows:

Command Description

SETSOURCE Specifies the relational databases from which an Essbase
outlineis build

SETTARGET Specifiesthe name of the Essbase server computer on which an
Essbase outline for an Essbase application and databaseis built

SETCATALOG | Specifiesthe OLAP Metadata Catal og that you created to store
OLAP models and metaoutlines

The STATUS command (see“STATUS’ on page 92) does not check or validate
the syntax for SET commands.
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LOAD commands use the information from the SET commands to |oad members,
data, or both. Use the LOAD commands as follows:

Command Description

LOADMEMBER | Loads membersinto an Essbase outline. You must load
members before you load data.

LOADDATA L oads data into an Essbase database. You cannot load data
without loading members.
LOADALL L oads both members and data into an Essbase database.

LOAD commands for small outlines (fewer than 1000 members) take afew
secondsto execute. Larger outlines (1000 or more members) take afew minutesto
afew hours, depending on the amount of data being loaded, the configuration of
the metaoutline, and the computer system capabilities. After executing LOAD
commands, wait a few seconds until the command prompt (- >) is displayed and
then use the STATUS command to check the success or failure of the command
execution.

See “Loading Dimensions and Members Using Essbase I ntegration Services
Shell” on page 106 for a sample sequence of commands for |oading members.

See “Loading Data Using Essbase Integration Services Shell” on page 107 for a
sample sequence of commands for loading data.

Using Informational Commands

The STATUS and VERSION commands provide processing status and system
release version information for you and can be used at any time in the sequence of
command execution.

Using Command Syntax and Execution

Essbase | ntegration Services Shell commands are not case-sensitive, but named
data sources, user I Ds, and passwords might be case-sensitive, depending on the
operating system and the RDBM S you are using. Enter the syntax exactly as
shown in this chapter for each command. Keyword parameters can appear in
any order.
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The commands require semicolons and parameters such as data source name
(DSN), user ID (UID), and password (PWD) to separate the command into
statements that indicate what kind of information you are providing; for example:

SETSOURCE " DSN=dat abase; Ul D=Sni t h; PWD=passwor d; "

You must separate the statements with a semicolon. The final semicolonis
optional. Do not use semicolons as part of data source names, because Essbase
Integration Services Shell recognizes semicolons as field separators. It is
recommended that you use double quotation marks around the parameters, as
shown in the preceding example.

In this Essbase I ntegration Services System Administrator’s Guide, all optional
syntax parameters are indicated by their enclosurein brackets| ]; however, do not
type the brackets when you enter the commands.

Press Enter to execute the commands.

Note: If you are unsure of a specific syntax, use Essbase Integration Services Console
to schedule member or data loads, or to create load scripts. An Essbase Integration
Services Shell batch file and a corresponding . cbs file are created automatically in
the | SHOVE\ Bat ch directory. You can reference, modify, and reuse the . cbs file for
future member and data loads. In the Schedule Essbase Load dialog box, be sure to
check the Save Script Only option instead of the Schedule option. For more information,
see “Recording Member and Data Load Scripts” on page 88.

Recording Member and Data Load Scripts

If you are creating scripts to perform loads or other tasks, you may want a script
generated by Essbase I ntegration Servicesto use asamodel or to check your script
syntax for Open Database Connectivity (ODBC) data source connection details.
Record aload script with Essbase Integration Services by performing aload and
recording it to ascript file.
[l Torecord aload script:

1. Start Esshase Integration Services Console and open a metaoutline.
2. Select Outline > and one of the following menu items:

« Member Load

. Dataload

« Member and Data Load
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3. Inthe Essbase Application and Database dialog box, type or select the
appropriate application and database names.

4. Click Next to display the Schedule Esshase L oad dialog box.

Savetheloadtoascript file by clicking Only Save L oad Script and then click
Save Scripts.

6. Inthe Save Script Asdiaog box, type a name for the script that you want to
save, and then click OK.

7. Click Finish to start the load or to complete scheduling of the load.

Running Essbase Integration Services Shell Script and
Batch Files

If you use a series of commands frequently or you must enter many commands to
complete atask, you can automate the task with ascript or batch file. Both are text
files.

« Ascriptfile(. cbs extension) contains Essbase Integration Services Shell
commands. You can run a script file from the operating system command
line or from within an operating system batch file.

« OnWindows platforms, abatch file (. bat extension) is an operating system
filethat calls multiple Essbase | ntegration Services Shell scriptsand isused to
run multiple sessions of Essbase Integration Services Shell commands. You
can run abatch file on the server from the operating system prompt.

« OnUNIX, shell scriptsare used in place of batch or script files.

When you run a script file, Essbase I ntegration Services Shell executes the
commandsin the order specified in the script until the program reaches the end of
thefile.

Running OLAP Command Script Files

Enter the following command at the command prompt to run a script filein
Essbase | ntegration Services Shell:

ol apicnd -fscriptFileName [> | ogFil eNane]

Replace scriptFileName with the name of the script file you are using. Replace
logFileNamewith the name of the filewhere you want the feedback from the script
to be recorded.
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For example, the following sample script file, ol ap_t bc. cbs, was created in a
text editor. This script connects to Essbase from the server console and generates
outlines for a sample database. In the following example, the st at us command
(see“STATUS’ on page 92) is used to check the success or failure of each
command. The st at us command returns the execution status in the Essbase
Integration Services Shell window.

I ogi n | abmachi nel

st at us

settarget "DSN=l abmachi nel; U D=hyperi on; PM\D=passwor d"

st at us

set catal og " DSN=TBC_MD; Ul D=t bc; PWD=passwor d"

st at us

set source " DSN=TBC; Ul D=t bc; PWD=passwor d"

st at us

| oadal | " OTL=TBC Met aout | i ne; APP=ol apt bc; DBN=Tbf 1; FLT_I D=1,
CALC_SCRI PT=#DEFAULT#; "

status

| oadal | " OTL=TBC Met aout | i ne; APP=ol apt bc; DBN=Tbf 2; FLT_I D=2;
OTL_CLEAR=Y; "

status

| oadal | " OTL=TBC Met aout | i ne; APP=ol apt bc; DBN=Tbf 3a; FLT_I| D=3;
OTL_CLEAR=N; CALC_SCRI PT=#DEFAULT#; "

st at us

| oadal | " OTL=TBC Met aout | i ne; APP=ol apt bc; DBN=Tbf 3ec; FLT_I D=3;
OTL_CLEAR=N; ESSC_SCRI PT=nyt est 1"

st at us

exit

To execute the ol ap_t bc. cbs script file, type

ol apicnd -fol ap_tbc. cbs

The following sample batch file, ol ap_t bc. bat , usesinput from a script file
named ol ap_t bc. cbs and saves the feedback in afile named ol ap_t bc. | og:

ol apicnd -folap_tbc.cbs > ol ap_tbc. | og
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Using Essbase Integration Services Shell
Commands

The following subtopics describe each command and provide the syntax for
entering the command. Each subtopic includes an example command entry for
your reference.

The following commands are described in the subtopics:
« “LOGIN" on page 92

« “STATUS’ on page 92

« “VERSION” on page 93

o« “SETSOURCE” on page 93

« “SETTARGET” on page 94

« “SETCATALOG” on page 94
« “LOADMEMBER” on page 95
« “LOADDATA” on page 98

o “LOADALL" on page 101

. “LOGOUT" on page 105

o “SHUTDOWN” on page 105

« “EXIT” on page 106

Unless otherwise noted, you must be logged in to Essbase Integration Server to
execute these commands.

The load commands in this topic are shown with an abbreviated syntax, which
includes the syntax required for incremental loads. To see the full syntax for
standard or incremental loads, use the Essbase I ntegration Services Consoleto
record a script for aload. For more information on recording load scripts, see
“Recording Member and Data L oad Scripts’ on page 88.
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LOGIN

The LOGIN command connects you to the Essbase I ntegration Server computer.
On a successful connection, the Essbase Integration Services Shell prompt
changes to show the name of the Essbase | ntegration Server computer to which
Essbase Integration Services Shdll is connected. This command returns an error if
you already are connected to the Essbase Integration Server computer.

Syntax

LOA N [/ Shost

| Shost TCP/IP name or number of the computer where Essbase | ntegration
Server isrunning

Example

LOG N cypress

STATUS

The STATUS command displays the processing status of the most recently issued
command. Use it to check the success or failure of all commands. After issuing a
command, wait a few seconds until the command prompt (->) is displayed, and
then enter the STATUS command.

The STATUS command does not check or validate the syntax for SET commands.

Syntax
STATUS

Example

Typing STATUS after issuing the LOADMEMBER command returns the
following message in the Essbase I ntegration Services Shell window:

LOADMEMBER execut ed successfully, elapsed tine is '22' seconds.
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VERSION

The VERSION command returns the release number of the Essbase Integration
Services software you are running.

Syntax
VERSI ON

Example

VERSION returns the release number for Essbase | ntegration Services software.

SETSOURCE

The SETSOURCE command enablesyou to identify one or more source databases
for Essbase Integration Server to use with aload command.

Syntax

SETSOQURCE " DSN=Pr i mar yODBCdat asour ce; Ul D=user nane;
PWD=passwor d[ ; ] [ DSN=Secondar y ODBCdat asour ce; Ul D=user nane;
PWD=password] [;]...[ DSN=Secondar yODBCdat asour ce;

Ul D=user nane; PND=passwor d] "

PrimaryODBC The primary ODBC data source name configured on the
datasource computer where Esshase Integration Server runs—case-sensitive

username The name for logging on to a primary or secondary ODBC data
source—case-sensitive

password The password for logging on to a primary or secondary ODBC
data source—case-sensitive

SecondaryODBC  The secondary ODBC data source name configured on the
datasource computer where Esshase Integration Server runs—case-sensitive

Example

SETSOQURCE " DSN=TBC; Ul D=TBC; P\\D=Passwor d; DSN=TBC2;
Ul D=TBC; PWD=Passwor d; DSN=TBC3; Ul D=TBC; PWWD=Passwor d"
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SETTARGET

The SETTARGET command enables you to identify atarget Essbase server
computer for Essbase Integration Server to use with aload command.

Syntax

SETTARGET DSN=Essbasedat aser ver nane;, Ul D=user nane,

PWD=passwor d[ ; ]

Essbase The TCP/IP name or number of the computer where Esshase
dataservername  OLAP Server isrunning

username The name for logging on to Essbase OLAP Server

password The password for logging on to Essbase OLAP Server—

case-sensitive

Example
SETTARGET " DSN=FI G, Ul D=TBC; PWD=Passwor d"

SETCATALOG

The SETCATAL OG command enablesyouto identify an OLAP Metadata Catalog
database for Essbase Integration Server to use with aload command.

Syntax
SETCATALOG DSN=0ODBCdat asour ce; Ul D=user nanme; PND=passwor d[ ; ]

ODBCdatasource The ODBC data source name configured on the computer where
Essbase Integration Server runs—case-sensitive

username The name for logging on to the ODBC data source—
case-sensitive

password The password for logging on to the ODBC data source—
case-sensitive

Example
SETCATALQOG " DSN=TBC_MD; Ul D=Fr ed; PWD=Passwor d"
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LOADMEMBER

The LOADMEMBER command initiates a member load operation on Essbase
Integration Server. The load environment must be set up properly before you
invoke the LOADMEMBER command. To set up the load environment, issue the
SET commands in any order. For more information, see “Using SET and LOAD
Commands” on page 86.

To learn the status of the member |oad invoked by the LOADMEMBER command,
wait until you see the command prompt (- >), then use the STATUS command.

Syntax

LOADVEMBER " OTL=Met aout | i ne; APP=EssbaseAppl i cati on;
DBN=EssbaseDat abase; [ FLT_NAME=Fi | t er nane; |

[FLT_ID=Filter_I D Nunber;][ ESSCMD_SCRI PT=EsscndScri pt nane; ]

[ DELETE_DB=Del et e_and_Rest or e _Dat abase; |

[ I NCUPD=! ncrenent al _Di nensi on_Updat e_Level ;]

[ 1 NCUPD_MEMBER=/ ncrement al _Menber_Load_Updat e _Level ;]

[ OTL_CLEAR=Del ete_All _Menbers_ First;] [ GUSERS=Essbaselsers; ]
[ ATTR_UPDATE_LEVEL=Aftri bute_Update Level[;]"

Metaoutline The name of the metaoutline—case-sensitive. This
metaoutline is used to extract data and create a Essbase
outline.

Essbase Application ~ The name of the Essbase application on the target Essbase
OLAP Server computer where the Esshase outlineis created.

Essbase Database The name of the Essbase database on the target Esshase
OLAP Server computer. Essbase Integration Server applies
this name to the Essbase outline.

Filtername/ Optional. You can specify afilter name or filter ID to use

Filter ID_ Number when loading data. Because the filter name and filter ID are
the same, do not specify both. If you do not specify either,
the default name (*DEFAULT) is used. The default filter ID
is1; any additional filters are numbered sequentially, starting
with the number 2. If the filter name contains a space,
encloseit in double quotation marks. For information about
creating filters, see the Esshase Integration Services Console
Help.
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Esscmd Scriptname

Delete and Restore
Database

Incremental Dimension
Update Level
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Optional. The name of an ESSCMD script. The script that
you define instructs Essbase to perform specified actions on
the Esshase database. These actions might include changing
amember tag or loading data from a worksheet into
user-defined members after you load the data from the
relational data source. The ESSCMD script must be in the

| SHOVE esscri pt directory.

Optional. The Delete and Restore Database parameter
directs the Esshase I ntegration Server whether or not to
delete all membersin the Essbase database before
performing a member load. When this option is selected
(DELETE_DB=Y), the options Delete All Members First,
Modify Esshase Users, and Incremental Update cannot be
used.

Values are as follows:

Y = Delete and restore (recreate) the Essbase database
during the member load process.

N = Do not delete and restore the Essbase database (thisis
the default).

Optional. Thelevel at which dimensions are updated during

an incremental member load. The format is:

I NCUPD=n-n, n-n, ... n-n[;]

Values for incremental update are as follows:

» Thefirst digit, n, represents the dimension ID of the
dimension to which the incremental update applies.

» Thesecond digit, n, representsthe member ID of thelevel
zero member of the hierarchy to which the incremental
update applies.
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Incremental Member  Optional. Specify 1, 2, 3, or 4. Member Load Update

Load Update Level options set the parameters for restructuring the database
during a member load. The option that you select affects any
subsequent data loads.

Values are as follows;

1= Preserveall data. Select to preserve all existing data that
applies to the changed outline when restructuring
occurs. Thisisthe default (I NCUPD_MEMBER=1).

2 = Discard all data. Select to clear all datafrom the
database.

3= Preservelevel 0 data. Select to preserve data only for
level zero members.

Thisisthe optimal restructure option if you change the
source database and need to recalcul ate the data, and if
all datarequired for the calculation isin level zero
members.

Selecting this option deletes all upper-level blocks
before restructuring. This reduces the disk space for
restructuring and improves cal culation time when the
database is recalculated. The upper-level blocks are
re-created when you calculate the database.

4 = Preserveinput data. Select to preserve only those blocks
containing data that is loaded. Many applications
contain datathat is entered at parent levels. Selecting
this option prevents del etion of any blocks that are
created by data load, whether they are non-level zero or
level zero (Ieaf member) blocks.

Delete all members Optional. Specify Y or N. Enter Y (Yes) for Essbase

first Integration Server to remove al members from the existing
database and then recreate the database by using the
members in the metaoutline. This process is slower than
creating or updating an Essbase outline without deleting the
members; therefore, do not delete all membersfirst unlessit
is necessary. You should delete all membersif, for example,
you know that some members have been removed from the
OLAP metaoutline and you want to build an Essbase outline
containing a smaller set of members. The defaultis N (No).
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EssbaseUsers Optional. Lists all user IDsthat can access the Esshase
application and database into which you are loading the
members. Commas separate user | Ds. For example,
@AJSERS="admi n", "l jones","ksm th".

AttributeUpdateLevel Thelevel at which attribute dimensions are updated. Values
are asfollows:

1= Remove all existing attribute dimensions from the
Essbase outline and use Global Settingsfrom the OLAP
metaoutline.

2 = Use Global Settings defined in the Esshase outline to
add new attribute dimensions but do not update existing
attribute dimensions. With this parameter, no new
members are added to an existing attribute dimension.

3= Use Globa Settings from the OLAP metaoutline and
perform updates to the existing attribute dimensions.
Essbase reports error conditionsfor any invalid attribute
members.

Example

LOADMEMBER " OTL=TBC Met aout | i ne;
APP=CLAP_TBC, DBN=Basi c; FLT_NAME=Bl ue filter;
| NCUPD=1- 2, 2-1, 3-2,4-2,5-1,5-2,5-3;

| NCUPD_MEMBER=1; "

LOADDATA

The LOADDATA command initiates adataload operation on Essbase Integration
Server. The load environment must be set up properly before you invoke this
command. To set up the load environment, issue the SET commandsin any order.
For more information, see “Using SET and LOAD Commands” on page 86.

LOADDATA takesafew secondsto execute. After executing LOADDATA, usethe
STATUS command to learn the status of the command execution.

Syntax

LOADDATA " OTL=Met aout | i ne; APP=EssbaseAppl i cati on;
DBN=EssbaseDat abase; [ FLT_NAME=Fi | t er nane; |
[FLT_ID=Filter_I D Nunber;] [ CALC_SCRI PT=Cal cScri pt nane; ]
[ ESSCMD_SCRI PT=EsscndScr i pt nane; ]
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[ I NCUPD=! ncrenent al _Di nensi on_Updat e_Level ;]
[ 1 NCUPD_DATA=/ ncrenent al _Data_Load _Updat e _Level ;]
[ @ASERS=EssbaseUsers][;]"

Metaoutline

EsshaseApplication

EssbaseDatabase

Filtername/
Filter ID_ Number

CalcScriptname

EsscmdScriptname

The name of the metaoutline. Essbase Integration Server
uses the specified metaoutline to extract data from the
relational data source to create an Essbase outline.

The name of the Essbase application on the target Essbase
OLAP Server computer where the Esshase outlineis
created.

The name of the Esshase database on the target Essbase
OLAP Server computer. Esshase Integration Server
applies this name to the Esshase outline.

Optional. You can specify afilter name or filter ID to use
when loading data. Because filter name and filter ID are
the same, do not specify both. If you do not specify either,
the default name (* DEFAULT) is used. The defaullt filter
ID is1; any additional filters are numbered sequentially,
starting with the number 2. If the filter name contains a
space, enclose it in double quotation marks. For
information about creating filters, see the Essbase
Integration Services Console Help.

Optional. The name of the calculation script. The
calculation script determines how Essbase calculates the
datavaluesin the database. If you do not select a
calculation script, Essbase Integration Server does not
perform a calculation.

Optional. The name of an ESSCMD script. The script that
you define instructs Essbase to perform specified actions
on the Esshase database. These actions might include
changing a member tag or loading data from a worksheet
into user-defined members after you load the datafrom the
relational data source. The ESSCMD script must bein the
| SHOVE esscri pt directory.
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Incremental Dimension  Optional. Thelevel at which dimensions are updated
Update Level during an incremental dataload. The format is:

I NCUPD=n-n, n-n,... n-n[;]
Values are as follows:

e Thefirst digit, n, represents the dimension ID of the
dimension to which the incremental update applies.

« Thesecond digit, n, represents the member ID of the
level zero member of the hierarchy to which the
incremental update applies.

Incremental DataLoad Optional. Data Load Update options determine how
Update Level Essbase | oads values from a data source to the database.
Specify 1, 2, or 3. Values are as follows:;

1= Overwrite. Select to replace the valuesin the database
with the values in the data source. Thisis the default
(I NCUPD_DATA=1).

2= Add. Select to add values in the data source to the
existing values in the database.

3= Subtract. Select to subtract the valuesin the data
source from the existing values in the database.

EsshaseUsers Optional. Listsall user IDsthat can access the Essbase
application and database into which you are loading the
members. Commas separate user |Ds. For example,
@AJSERS="adm n","|jones", "ksni th".

Example

LOADDATA " OTL=TBC Met aout | i ne;
APP=CLAP_TBC, DBN=Basi c;

FLT_NAME=Bl ue filter;

| NCUPD=1-2, 2-1, 3-2,4-2,5-1,5-2,5-3;
| NCUPD_DATA=1; "

100 m Essbase Integration Services System Administrator’s Guide



Using Essbase Integration Services Shell

LOADALL

The LOADALL command initiates aload of both members and data on Essbase
Integration Server. The load environment must be set up properly before you

invoke this command. To set up the load environment, issue the SET commands
in any order. For more information, see “Using SET and LOAD Commands’ on

page 86.

LOADALL takes afew seconds to execute. After executing LOADALL, use the
STATUS command to learn the status of the command execution.

Note: If you want an ESSCMD script to execute between a member and data load, use
the LOADMEMBER and LOADDATA commands instead of the LOADALL command.

Syntax

LOADALL "OTL=Met aout | i ne; APP=EssbaseAppl i cat i on;
DBN=EssbaseDat abase; [ FLT_NAME=Fi | t er nane; |

[FLT_I D=Fil ter_I D Number;] [ CALC_SCRI PT=Cal cScri pt nang; ]
[ ESSCMD_SCRI PT=EsscndScri pt nane; ]

[ DELETE_DB=Del et e and Restore Database;]

[ I NCUPD=! ncrenent al _Di nensi on_Updat e_Level ;]

[ | NCUPD_MEMBER=/ ncrement al _Menber_Load_Updat e _Level ;]
[ 1 NCUPD_DATA=/ ncrenment al _Data Load _Updat e _Level ;]

[ OTL_CLEAR=Del ete all nenbers first;][ @USERS=Essbaselsers]|[;]
[ ATTR_UPDATE_LEVEL=Aftri but eUpdat eLevel ] [;]"

Metaoutline The name of the metaoutline. Essbase Integration Server
uses the specified metaoutline to extract data from the
relational data source to create an Essbase outline.

EsshaseApplication The name of the Essbase application on the target Esshase
OLAP Server computer where the Essbase outlineis created.

EsshaseDatabase The name of the Essbase database on the target Essbase
OLAP Server computer. Esshase Integration Server applies
this name to the Essbase outline.
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Filtername/
Filter ID_ Number

CalcScriptname

EsscmdScriptname

Delete and Restore
Database
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Optional. You can specify afilter name or filter ID to use
when loading data. Because filter name and filter ID are the
same, do not specify both. If you do not specify either, the
default name (* DEFAULT) is used. The default filter ID is 1;
any additional filters are numbered sequentially, starting
with the number 2. If the filter name contains a space,
encloseit in double quotation marks. For information about
creating filters, see the Esshase Integration Services Console
Help.

Optional. The name of the calculation script. The
calculation script determines how Essbase cal cul ates the data
valuesin the database. If you do not select a calculation
script, Essbase Integration Server does not perform a
calculation.

Optional. The name of an ESSCMD script. The script that
you define instructs Essbase to perform specified actions
on the Esshase database. These actions might include
changing a member tag or loading data from a worksheet
into user-defined members after you load the data from the
relational data source. The ESSCMD script must be in the
| SHOVE\ esscri pt directory.

Optional. The Delete and Restore Database parameter
directs the Essbase Integration Server whether or not to
delete all members and data in the Essbase database before
performing a member and data load. When this option is
selected (DELETE_DB=Y), the options Delete All Members
First, Modify Esshase Users, and Incremental Update cannot
be used.

Values are as follows:

Y = Delete and restore (recreate) the Esshase database
during the member load process.

N = Do not delete and restore the Essbase database (thisis
the default).
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Incremental Dimension Optional. Thelevel at which dimensions are updated during
Update Level an incremental member and data load. The format is:

I NCUPD=n-n, n-n,...n-n[;]
Values are as follows:

e Thefirst digit, n, represents the dimension ID of the
dimension to which the incremental update applies.

« Thesecond digit, n, representsthe member ID of thelevel
zero member of the hierarchy to which the incremental
update applies.

Incremental Member  Optional. Specify 1, 2, 3, or 4. Member Load Update

Load Update Level options set the parameters for restructuring the database
during amember load. The option that you select affects any
subsequent data loads. Values are as follows:

1= Preserveal data. Select to preserve al existing data that
applies to the changed outline when restructuring
occurs. Thisisthe default (I NCUPD_MEMBER=1).

2 = Discard all data. Select to clear all datafrom the
database.

3= Preservelevel 0 data. Select to preserve data only for
level zero members.

Thisisthe optimal restructure option if you change the
source database and need to recalcul ate the data, and if
all datarequired for the calculation isin level zero
members.

Selecting this option deletes all upper-level blocks
before restructuring. This reduces the disk space for
restructuring and improves cal culation time when the
database is recalculated. The upper-level blocks are
re-created when you calculate the database.

4 = Preserveinput data. Select to preserve only those blocks
containing data that is loaded. Many applications
contain datathat is entered at parent levels. Selecting
this option prevents deletion of any blocks that are
created by data load, whether they are non-level zero or
level zero (Ileaf member) blocks.
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Incremental Data Load Optional. Datal oad Update options determine how Essbase

Update Level

Delete all members
first

EssbaseUsers

AttributeUpdatelevel

loads values from a data source to the database. Specify 1, 2,
or 3. Thisisthe default (I NCUPD_DATA=1).

Values are as follows:

1= Overwrite. Select to replace the values in the database
with the values in the data source.

2 = Add. Select to add values in the data source to the
existing values in the database.

3 = Subtract. Select to subtract the valuesin the data source
from the existing valuesin the database.

Optional. Specify Y or N. Enter Y (Yes) for Esshase
Integration Servicesto removeall membersfromtheexisting
database and then recreate the database by using

the members in the metaoutline. This processis slower than
creating or updating a Essbase outline without deleting
members; therefore, do not delete all membersunlessitis
necessary. You should delete all membersif, for example,
you know that some members have been removed from the
OLAP metaoutline and you want to build the Esshase outline
containing asmaller set of members. The default is N (No).

Optional. Listsall user IDsthat can access the Essbase

application and database into which you are loading

members. Commas separate user | Ds. For example,

@AJSERS="admi n","|jones", "ksnmi th".

Thelevel at which attribute dimensions are updated. Values

are asfollows:

1= Remove all existing attribute dimensions from the
Essbase outline and use Global Settings from the OLAP
metaoutline.

2= Use Global Settings defined in the Esshase outline to
add new attribute dimensions but do not update existing
attribute dimensions. With this parameter, no new
members are added to an existing attribute dimension.

3= Use Global Settings from the OLAP metaoutline and
perform updates to the existing attribute dimensions.

Essbase reports error conditions for any invalid attribute
members.
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Example

LOADALL " OTL=TBC Met aout | i ne; APP=0OLAP_TBC, DBN=Basi c;
FLT_NAME=Bl ue filter" CALC_SCRI PT=#DEFAULT#;

| NCUPD=1-2, 2-1, 3-2,4-2,5-1,5-2,5-3;

| NCUPD_MEMBER=1; | NCUPD _DATA=1;"

LOGOUT

The LOGOUT command logs you out of Essbase Integration Server. On a
successful logout, the Essbase | ntegration Services Shell prompt changes to
LOCAL.

Syntax
LOGOUT

Example

LOGOUT logs you out of Essbase Integration Server.

Note: If you log out of Essbase Integration Server, you no longer have an active
session. To execute another command, you must log on to Essbase Integration Server
again.

SHUTDOWN

The SHUTDOWN command shuts down Essbase | ntegration Server. You must
be logged on to Essbase Integration Server before you can use this command.

Syntax
SHUTDOWN

Example

SHUTDOWN shuts down Esshase Integration Server.
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EXIT

The EXIT command exits Esshase Integration Services Shell and closes the
Essbase | ntegration Services Shell window. Before you exit from Esshase
Integration Services Shell, Essbase Integration Server automatically executes a
LOGOUT command.

Syntax
EXIT

Example

EXIT logs you out of Essbase Integration Server and closes the Essbase
Integration Services Shell window.

Loading Dimensions and Members Using
Essbase Integration Services Shell
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You can perform a member load by using Essbase Integration Services Shell
instead of Essbase Integration Services Console.

You can manually schedule the batch file by using the AT servicein WindowsNT
and Windows 2000 or the cron scheduling daemon on UNIX systems. If you are
not sure how to schedule the batch file manually, see the operating system
documentation.

To load members and dimensions when using Essbase I ntegration Services Shell,
follow the same basi ¢ stepsfor |oading members as you would when using Essbase
Integration Services Console:

1. Log on to the Esshase Integration Server computer by using the LOGIN
command; for example

LOG N cypress

2. Connect to the external data source by using the SETSOURCE command; for
example

SETSOQURCE DSN=TBC; Ul D=TBC, PWD=passwor d
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3. Connecttothe Essbase server computer by using the SETTARGET command,;
for example

SETTARGET DSN=sequoi a; U D=sys; P\\D=passwor d

4. Connect to OLAP Metadata Catalog by using the SETCATALOG command,;
for example

SETCATALOG DSN=TBC_MD; Ul D=TBC; PWD=passwor d
5. Start the member load by using the LOADMEMBER command; for example

LOADMEMBER " OTL=TBC Met aout | i ne; APP=CLAP_TBC;
DBN=Basi c; FLT_NAME=Fi | t er 1"

Loading Data Using Essbase Integration

Services Shell
You can perform adatal oad by using Essbase | ntegration Services Shell instead of
Essbase | ntegration Services Console.

You can manually schedule the batch file by using the AT service on WindowsNT
and Windows 2000 or the cron scheduling daemon on UNIX systems. If you are
not sure how to schedule a batch file manually, see the operating system
documentation.

[l Toload data by using Essbase Integration Services Shell, follow the same basic
steps for loading data as you would using Essbase I ntegration Services Console:

1. Log on to Essbase Integration Server by using the LOGIN command; for
example

LOG N FI G

2. Connect to the external data source by using the SETSOURCE command; for
example

SETSOQURCE DSN=TBC; Ul D=TBC, PWD=passwor d

3. Connect to the OLAP Essbase server by using the SETTARGET command,;
for example

SETTARGET DSN=sequoi a; U D=sys; PWD=password
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4. Connect to OLAP Metadata Catalog by using the SETCATALOG command,;
for example

SETCATALOG DSN=TBC_MD; Ul D=TBC; PWD=passwor d
5. Start the dataload by using the LOADDATA command; for example

LOADDATA " OTL=TBC Met aout | i ne; APP=OLAP_TBC, DBN=Basi c;
FLT_NAME=Fi | ter 1"
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This appendix provides a partial list of the error messages generated by Esshase
Integration Server. Error messages are grouped into the following categories:

« “Member Load Error Messages” on page 109

« ‘“Dataload Error Messages’ on page 113

« “Drill-Through Report Error Messages’ on page 113
« “OLAPICMD Session Error Messages’ on page 115
« “Miscellaneous Error Messages’ on page 116

The complete list of error messagesislocated | SHOVE/ bi n/ error . t xt .

Member Load Error Messages

Table 8 lists error messages that Essbase Integration Server may generate during
amember load. Italicized words represent variable names inserted in the error
message. Refer to the error message number in the first column and make anote
of it if you need to contact Hyperion Technical Support with a problem.

Table 8: Essbase Integration Server Member Load Error Messages

Message

Number Message Content

049 Detected metadata join problem (table.column < - > table.column).

050 Encountered unknown ODBC exception while opening database.
Aborting the command.

064 Failed to add database Essbase database.
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Table 8: Essbase Integration Server Member Load Error Messages (Continued)

Message

Number Message Content

065 Failed to add dimension dimension.

066 Failed to add Esshase member member (%d).

067 Failed to add Esshase member member (child of shared parent).

068 Failed to add Esshase member member (DUPLICATE).

069 Failed to add Esshase member member (DUPLICATE, ignored).

070 Failed to add Essbase member member (no parent or sibling members
found).

071 Failed to add Essbase member member, %d.

072 Failed to add Essbase member member; the member exists.

073 Failed to add formula formula.

074 Failed to add member member.

075 Failed to add metaoutline member member.

076 Failed to add user attribute user-defined attribute.

077 Failed to create alocal context.

078 Failed to create alocal outline.

079 Failed to create application Essbase application.

080 Failed to create dimension dimension.

083 Failed to get information for parent of recursive hierarchy member.

085 Failed to get metadata for dimension.member.

088 Failed to initialize Essbase API.

089 Failed to open outline Essbase outline.

093 Failed to restructure Essbase outline.

095 Failed to update Esshase server (NULL HEADER)

097 Filter metaoutline filter doesn’t exist for metaoutline metaoutline.

098 Filter expression length exceeded the limit of maximum bytes bytes.
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Table 8: Essbase Integration Server Member Load Error Messages (Continued)

Message
Number

Message Content

115

Incremental update specification incremental update specification
string isincorrect.

126

Invalid aggregation function aggregate function for table.column.

129

Invalid esscmd script name esscmd script.

130

Invalid parameter parameter.

132

Invalid parameter string.

142

Metadata error: property ID is not avaid property for member or
dimension.

143

M etaoutline validation error. Recursive hierarchy member, a
recursive member cannot have aggregation filter.

144

Metaoutline validation error. Filter = member filter, is not associated
with any member.

188

Unknown exception encountered while opening dimension
dimension.

189

Unknown exception encountered while opening member member.

190

Unknown exception encountered while opening metaoutline
metaoutline.

341

Failed to Login to Essbase Server.

342

Failed to Get Esshase Settings.

344

Failed to unload database.

345

Failed to delete database.

346

Failed to close outline.

347

Failed to read outline.

349

Failed to unlock Database database.

350

Failed to save outline.

351

Unable to process state for Essbase command.

352

Failed to get access permissions for application.
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Table 8: Essbase Integration Server Member Load Error Messages (Continued)

Message

Number Message Content

353 Failed to set access permissions for application.

354 Failed to get access permissions for database.

355 Failed to set access permissions for database.

356 No member found.

357 Essbase Error: error definition.

358 Failed to get user attributes.

360 Failed to add member to outline.

361 Failed to cal culate the data.

362 Failed to get parent.

363 Failed to get member.

364 Failed to move member.

365 Failed to get shared member.

366 Failed to get member information.

367 Failed to sort outline.

377 IS Error: Unable to delete outline.

378 IS Error: SQL Generation for member |oad failed.

379 IS Error: Database close operation failed after |oad.

380 IS Error: Catalog close operation failed after load.

381 IS Error: Esshase close operation failed after load.

382 IS Error: No OLAP model name specified.

383 IS Error: Failed to open OLAP model OLAP model.

384 IS Error: Failed to close OLAP Metadata Catalog OLAP Metadata
Catalog.

385 Failed to create virtual model.

386 Member |oad completed with errors.

387 Member [oad terminated due to error.
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Data Load Error Messages

Table 9 lists the error messages that Essbase | ntegration Server may generate
during adataload. Italicized words represent variable names inserted in the error
message. Refer to the error message number in the first column and make a note
of it if you need to contact Hyperion Technical Support with a problem.

Table 9: Essbase Integration Server Data Load Error Messages

Message
Number

Message Content

034

Cdll load exceptions encountered.

047

Data load exceptions encountered. ? , amount.

063

Failed to activate Essbase_application.Essbase.database.

082

Failed to execute esscmd script esscmd script.

369

Dataload completed with errors.

370

Data load terminated with errors.

388

Failed to get dataload SQL.

389

Failed to get dimbuild SQL.

390

Number of dataload SQLs not equal to number of hierarchies.

Drill-Through Report Error Messages

Drill-through reports are created using the Essbase Integration Services Console
OLAP Metaoutline standard user interface and are viewed using Essbase
Spreadsheet Add-in for Excel or Lotus 1-2-3.
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Table 10 lists the error messages that Essbase | ntegration Server may generate to
Essbase users viewing Drill-through reports. Italicized words represent variable
namesinserted in the error message. Refer to the error message number in thefirst
column and make a note of it if you need to contact Hyperion Technical Support
with a problem.

Table 10: Essbase Integration Server Drill-Through Report Error Messages

Message

Number Message Content

081 Failed to enable DTS Member member.

087 Failed to get the universal member handle.

125 I ntersection element member does not exist in table.column.

131 Invalid parameter count for the drill-through request. Aborting...

153 Received NULL pointer in DTAttributes( ) for Report =
Drill-Through report.

154 Received NULL pointer in GetDTData () for Report = Drill-Through
report.

155 Received NULL pointer in GetDTDomain ().

156 Received NULL pointer in GetDTReport ().

157 Received NULL pointer in SetDTReport ().

183 Too many Drill-Through reports defined (exceeded Esshase metadata
size limit). Drill-Through is disabled for this outline.

186 Unknown exception in GetDTReport ().

359 Essbase Error: Invalid Drill-Through Metadata.

369 IS Error: Dataload completed with errors.

370 IS Error: Dataload terminated due to errors.

371 IS Error: Unable to log in to data source.

372 IS Error: Unable to log in to OLAP Metadata Catal og.

373 IS Error: Unable to log in to Essbase Server.

374 IS Error: Unable to read Metaoutline information.
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Table 10: Essbase Integration Server Drill-Through Report Error Messages

Message

Number Message Content

375 IS Error: Data calculation failed.

376 IS Error: Esscmd script execution failed.

OLAPICMD Session Error Messages

Table 11 lists the error messages, and the associated message numbers for both
Windows and UNIX, that Essbase Integration Server may generate during an
Essbase Integration Services Shell (OLAPICMD) session. Italicized words
represent variable namesinserted in the error message. Refer to the error message
number in the first or second column and make a note of it if you need to contact
Hyperion Technical Support with a problem.

Table 11: Essbase Integration Services Shell Error Messages

Windows UNIX

Message Message

Number Number Message Contents

Any error 0 Network Errors.

number less than

or equal to

20000000

21195318 054 Please log in to an Integration Server before
issuing this command.

21195371 107 Unable to log in to data source.

21195372 108 Unable to log in to OLAP Metadata Catal og.

21195373 109 Unable to log in to Essbase Server.

21195409 145 Unable to log in to Integration Server.

31195130 250 Invalid parameters load command parameter(s).

31195314 178 Unsupported command command.

31195370 234 Dataload terminated with errors.

31195374 238 Unable to read metaoutline information.
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Table 11: Essbase Integration Services Shell Error Messages (Continued)

Windows UNIX

Message Message

Number Number Message Contents

31195375 239 Data calculation failed.

31195376 240 Esscmd script execution failed.

31195377 241 Unable to delete outline.

31195379 243 Database close operation failed after load.

31195380 244 Catalog close operation failed after load.

31195381 245 Essbase close operation failed after |oad.

31195383 247 Failed to open OLAP model model name.

31195387 251 Member load terminated with errors.

41195059 75 Exceeded the time governor seconds, aborting
the command.

41195369 105 Dataload completed with errors.

41195386 122 Member load completed with errors.

Miscellaneous Error Messages

Table 12 lists the miscellaneous error messages that Essbase Integration Server
may generate during OLAP model and metaoutline creation and during data and
member loads. Italicized words represent variable names inserted in the error
message. Refer to the error message number in the first column and make a note
of it if you need to contact Hyperion Technical Support with a problem.

Table 12: Essbase Integration Server Miscellaneous Error Messages

Message

Number Message Contents

004 Metaoutline failed validation. Database measures not specified.

007 Add job failed.

017 Syntax Syntax error at character location in the filter expression
filter.
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Table 12: Essbase Integration Server Miscellaneous Error Messages (Continued)

Message
Number

Message Contents

018

Member cannot have aggregation filter. Only leaf members can have
aggregation filters.

054

Error message unavailable for this error.

057

Essbase server on Essbase server computer is not enabled with
Essbase I ntegration Services option. Please inform your system
administrator.

084

Failed to get job info (OS error Job-ID).

086

Failed to get the ODBC message.

090

Failed to remove temporary batch file (OS error operating system
error).

091

Failed to remove job (OS error operating systemerror).

092

Failed to remove old job (OS error operating systemerror).

094

Failed to schedule job (OS error operating systemerror).

096

Fatal error.

124

Internal system error. Please contact Technical Support with the error
number 1999999.

127

Invalid command line option OLAP Integration Server switch.

128

Invalid datatype specification data type.

133

Invalid session identifier; please log in to Essbase | ntegration
Services again.

159

Replace Failed member transformation.

185

Trying to access invalid memory. Contact Technical Support.

187

Unknown ODBC exception encountered while closing database.

206

Syntax Syntax error at character location in the filter expression
filter.

207

Esshase Integration Servicesis already running on this machine.

208

Failed to release locks.
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Table 12: Essbase Integration Server Miscellaneous Error Messages (Continued)

Message

Number Message Contents

333 ODBC Error: Encountered unknown ODBC exception while opening
database.

334 ODBC Error: Encountered unknown ODBC exception while closing
database.

336 ODBC Error: Failed to get ODBC Error message for error number.

338 IS Error: Error during parsing Load Parameters.

343 Essbase Error; Esshase Server on Essbase server computer is not
enabled with Esshase Integration Services option.

344 Failed to unload database.

348 Failed to get information for Database database.

391 IS Error: Unable to get tables for pattern name SQL regular
expression pattern from data source.

392 IS Error: Unable to get columns for table relational table from
data source.

393 IS Error: Unable to extract foreign keys for tables relational table,
relational table from data source.

394 IS Error: Failed to bind columns.

395 IS Error: Failed to fetch next row.

396 IS Error: Failed to get number of columns.

397 IS Error: Failed to get column attributes.

398 IS Error: Failed to get statement handle.

399 IS Error: Failed to rel ease statement handle.

400 IS Error: Failed to get number of rows.

401 IS Error: Unable to delete the model model name.
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accountsdimension. A dimension type that makes accounting intelligence
available. Y ou can tag only one dimension as Accounts; you do not have to have
an accounts dimension.

Add Joins mode. In Essbase Integration Services, a state in which you can draw
lines to define joins between objects in the OLAP model.

aggregate. See consolidate.
aggregation level. See consolidation level.
alias. An dternative name for a dimension, member, or description.

alias column. In Essbase Integration Services, a column in the data source that
contains the aliases for a member level in the metaoutline.

alternate name. Seealias.

ancestor. A branch member that has members below it. For example, ina
dimension that includes years, quarters, and months, the members Qtr2 and 2001
are ancestors of the member April.

application. InHyperion Essbase, acontainer for one or more Hyperion Essbase
databases and files, such as calc scripts and data load rules, that are related to the
databases.

Architect. See Esshase Integration Services Console.

attribute. A classification of amember in adimension. Y ou can specify an
attribute to select and group members with a specified attribute and to perform
calculations and application-specific functions. For example, aProduct dimension
can have several attributes, such as Size and Flavor. A specific member of the
Product dimension can have the Size attribute 8 and the Flavor attribute Cola.
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base dimension. A standard dimension that is associated with one or more
attribute dimensions. To classify a member of a base dimension, you associate it
with a member of one or more attribute dimensions that describes the
classification, such as a specific flavor. For example, assuming products have
flavors, the Product dimension is the base dimension for the Flavors attribute
dimension.

block. The primary storage unit within Essbase. A block is amultidimensional
array representing the cells of all dense dimensions.

branch. A member of ahierarchy that may or may not contain leaf members.
Builder. See Essbase Integration Services Console.
catalog. See OLAP Metadata Catalog.

cell. A unit of data representing the intersection of dimensionsin a
multidimensional database; the intersection of arow and acolumn in aworksheet.

child. A member that has a parent above it in the database outline.

column. Inrelationa databases, avertical part of atable. Also known as afield.
A column contains all the values for a specific type of information. Every column
has a name and a particular datatype. For example, a column may contain the
name or employee number for each employee.

Command Interface. See Essbase Integration Services Shell.

concatenation. An operation that joins two characters or strings in the order
specified, forming one string whose length is equal to the sum of the lengths of the
two characters or strings. For example, the strings “New York “ and “Library”,
when concatenated, become “New York Library”.

condition. Inrelationa databases, a data extraction criterion. For example, you
can apply a condition to extract only the data that begins with the letter A.

consolidate. The process of gathering data from dependent entities and
aggregating the data to parent entities. Once you enter or load datainto child
entities, you perform a consolidation to aggregate the data through the
organization. As data consolidates, intercompany processing, conversion
methods, equity adjustments, and minority ownerships perform calculations on the
data.

consolidation level. The top of an aggregation hierarchy or any branch or
sub-branch below the top, including the input (leaf) portion of the hierarchy.

data block. See block.
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data cleansing. The process of making inconsistent data consistent. Examples of
inconsistent data are data in which some values are incorrect or not of the correct
datatype.

datafile. A file containing data blocks; Essbase generates the data file during a
dataload and storesit on disk.

dataload. Theprocessof populating an Essbase database with data. L oading data
establishes actual values for the cells defined by the structural outline of the
database.

data point. Seecell.

data type. Definesthe kind of datathat a column can contain. For example,
columns with the Numeric data type contain numbers.

data value. Seecell.

database. A collection of related information. Each unit (record) of the database
istypically organized in afixed format to make it easy to retrieve selected portions
of the dataon demand. Each record is made up of one or more datafields, and each
datafield can hold one piece of data (known as avalue).

database administrator (DBA). Anindividual who administers database
servers, such as Essbase, and who may a so design, maintain, and create databases.

database outline. Seeoutline.

DateTimetransformation. A set of instructions that defines how to change or
reformat arelational database DateTime data type to your choice of date format.

DBMS. Seerelational database management system (RDBMS).

denormalization. The process of adding redundancy to datain a database,
typically by joining tables to form more complete sets of datain theindividual
tables. This processis performed for the purpose of increasing data retrieval
performance. Contrast with normalization.

dense dimension. A dimension likely to contain data for every combination of
dimension members. For example, atime dimension istypicaly adense
dimension because it contains all combinations of all members. Contrast with
sparse dimension.

descendant. Any member below a parent in the database outline. For example,
in adimension that includes years, quarters, and months, the members Qtr2 and
April are descendants of the member Y ear.

detail member. Seeleaf member.

Essbase Integration Services System Administrator's Guide m 121



Glossary

122 m

dimension. A datacategory that isused to organize businessdatafor retrieval and
preservation of values. Each dimension usually contains a hierarchy of related
members grouped withinit. For example, a'Y ear dimension often includes
members for each time period, such as quarters and months. Other common
business dimensions may be measures, natural accounts, products, and markets.

dimension branch. A collection of dimension tables organized in a hierarchical
structure, with one of the dimension tables joined directly to the fact table. A
dimension branch defines a single, potential Hyperion Esshase dimension in an
Essbase | ntegration Services metaoutline.

dimension build rules. In Hyperion Essbase, a set of operations similar to data
load rules. Instead of loading data, the dimension build rules modify the outline
based on datain the external data source file.

dimension table. A container in the OLAP model for one or more relational

tables that define a potential Hyperion Essbase dimension. When one dimension
tablejoinsto another dimension table, forming adimension branch, the dimension
iscomposed of the columnsof all of the dimension tablesin the dimension branch.

dimension type. A property in the OLAP model and in the metaoutline that
defines which tables form the Hyperion Essbase accounts, time, and standard
(default) dimensions.

drill-through report. Direct accessby Spreadsheet Add-in usersto datastoredin
therelational data source. Defined in Essbase Integration Services, adrill-through
report is based on intersection levels (member sets) that Spreadsheet Add-in users
double-click to view detail information that is not stored in the Essbase database.

duplicate member. The second occurrence of a member name in a data source.
Users can determine whether Essbase I ntegration Server ignores duplicate
members or adds them as shared members. See also shared member.

Dynamic Time Series. A processthat isused to perform dynamic period-to-date
reporting for all values associated with a query.

Essbase database. A repository of datawithin Hyperion Essbase that contains a
multidimensional data storage array. Each database consists of a defined storage

structure (a database outline), data, security definitions, and other associated files,
such as calc scripts or dataload rules. See also application.
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Essbase Integration Server. The server component of the Essbase Integration
Services product family. Essbase Integration Server usestheinformation storedin
the OLAP Metadata Catal og to extract the dimension names and member names
needed to build a Hyperion Essbase outline from the data source. When the
Hyperion Essbase outline is complete, Essbase I ntegration Server extracts data
from the data source, performs the operations specified in the metaoutline, and
loads the data into the Hyperion Esshase database.

Essbase Integration Services Console. The client component of the Hyperion
Integration Services product family. This graphic interface tool is used to create
OLAP models and metaoutlines, and to load data into a Hyperion Essbase
database.

Esshase I ntegration Services Shell. In Essbase Integration Services, a
command-line tool that you can use to perform common operations on the
Hyperion Essbase outline and the data in the Hyperion Essbase database. For
example, you can use the LOADDATA command to load data.

Esshase kernel. A layer of the Essbase server that provides the foundation for a
variety of functionality, including data loading, calculations, spreadsheet

lock& send, partitioning, and restructuring. The Esshase kernel reads, caches, and
writes data; it manages transactions; and it enforces transaction semantics to
ensure data consistency and data integrity.

Esshase OLAP Server. A Hyperion server that locates and accesses
multidimensional data.

Essbase outline. See outline.

fact table. A container for oneor morerelational tablesthat definethe datavalues
for each dimension intersection in the OLAP model. For example, if the OLAP
model contains Products, Region, and Y ear dimensions, the fact table might
include data values for the number of units of Product A soldin New York in
January.

field. (1) InHyperion Essbase, avalueor iteminadatasourcefilethat isretrieved
from a Hyperion Essbase database. (2) In relational databases, a space allocated
for aparticular item of information. Fields are the smallest units of information
you can access. Most fields have certain characteristics associated with them. For
example, some fields are numeric, whereas others are textual. Every field hasa
name.

file delimiter. Oneor more characters, such asacommayf(,), separating fieldsina
data source.
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filter. (1) In Hyperion Esshase, amethod for controlling access to database cells.
A filter isthe most detailed level of security, allowing you to define the varying
access levelsthat users can haveto data. (2) In Essbase Integration Servicesandin
relational databases, a method for controlling which data you retrieve from a
relational database. For example, you can choose to retrieve products only in the
Product A product family. A filter contains one or more conditions.

foreign key. Inrelational databases, a column whose data values correspond to
the values of akey column in another relational table. See also key column and

primary key.

formula. In Hyperion Essbase, a combination of operators and functions as well
as dimension names, member names, and numeric constants. Formulas are used to
calculate relationships between members of a Hyperion Essbase database.
@VAR(Actual, Budget) is an example of aformula.

generation. A layer in ahierarchical tree structure that defines member
relationships in a database. For example, Essbase orders generations
incrementally from the dimension (generation 1) down to the child members.

generation name. A unique name that describes a generation.

hierarchy. A set of multidimensional relationshipsin an outline, often created in
atreeformation. For example, parents, children, and generations represent a
hierarchy.

Hybrid Analysis. Theintegration of arelational database with an Essbase
multidimensional database so that lower-level dataremainsin therelational
database and is mapped to summary-level dataresiding in the Essbase database.
Hybrid Analysis alows Essbase to take advantage of the mass scalability of a
relational database while maintaining amultidimensional view of thedatainalive
environment.

Hyperion Integration Server Desktop. See Essbase Integration Services
Console.

index. (1) In Hyperion Essbase, a method of retrieving data based on sparse
dimensions. Also refersto theindex files, collectively. (2) In relational databases,
pointersthat arelogically arranged by the values of akey. Indexes optimize access
to relational data.

index cache. In Hyperion Esshase, a buffer in memory that holds index pages.

index entry. In Hyperion Essbase, a pointer to an intersection of sparse
dimensions. Each index entry pointsto ablock on disk and locates a particul ar cell
within the block by means of an offset.
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index file. In Hyperion Essbase, afile used to store data retrieval information. It
resides on disk and contains index pages.

index page. InHyperion Esshase, asubdivision of anindex file containing entries
that point to data blocks.

input block. A type of data block that has at least one loaded data value.

input data. Any datathat isloaded from a data source and is not generated by
calculation.

Integration Server. See Essbase Integration Server.

integrity constraint. Inrelational databases, arule stating that each row should
have an entry for each required key column.

Intelligent Help. In Essbase Integration Services, procedural help displayedin a
dockable window that accompanies the OLAP Model and OLAP Metaoutline
main windows. Intelligent Help provides numbered procedures and links to new
automati c-detection options and frequently used functions.

intersection level. In Essbase Spreadsheet Add-in, a Hyperion Essbase member
combination that defines a specific value. For example, the member combination
Actual, Root Beer, Sales, Jan, East represents the actual January sales value for
root beer in the Eastern region.

join. Creates arelationship between two tables based on matching key column
values in relational databases and as an SQL command.

join columns. In Esshase Integration Services, two relationa table columns that
are joined from one table to another.

key column. Inrelational databases, a column or columns that form a unique
identifier for each row. For example, EMPLOY EE_ID might be akey column.

leaf member. A member that has no children.

left frame. (1) In the Essbase Integration Services Console OLAP Metaoutline
main window, the area on the left that enables you to view alist of dimensions
previously defined in the OLAP model. (2) Inthe OLAP Model main window, the
areaon the left that displays alist of the tables and views available in a source
relational database.
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level. (1) InHyperion Essbase, alayer of ahierarchical tree structure that defines
database member relationships. Hyperion Essbase numbers levelsincrementally
from the leaf member (level 0) up to the dimension member. (2) In Essbase
Integration Services, the distance of a dimension table from the fact table in the
OLAP model. For example, if atableislevel 2, it is separated from the fact table
by two links.

level O block. A datablock that iscreated for sparse member combinations when
al of the members of the sparse combination are level 0 members.

level 0 member. Seeleaf member.
level name. A unique name that describes alevel.

load member. In Esshase Integration Services, amember in a user-defined
dimension into which datais loaded. Only user-defined dimensions require load
members. For al non user-defined dimensions, Essbase Integration Server knows
how to load members and data into the Hyperion Essbase database.

load properties. In Esshbase Integration Services, a set of rulesthat determine
what actions the product performs on member level names and data as they are
loaded.

logical column. In Essbase Integration Services, a column created by
mani pul ating the datain one or more physical columns. See also column. Contrast
with physical column.

logical table. In relational databases, atable created by manipulating columns
from one or more physical tables. The logical tableis only aview of the data; the
columns remain stored in the original tables and are not physically duplicated in
the logical table. See also view. Contrast with physical table.

mathematical operator. A symbol that defines how datais calculated. A
mathematical operator can be any of the standard mathematical or Boolean
operators, for example, +, -, *, /, and %. Mathematical operators are used in
formulas, and outlines.

MDDB. See multidimensional database (MDDB).

measur es. Datavaluesthat a user wantsto track, such as Unit_Price and
Discount. By default, measures values map to the accounts dimension in the
OLAP model, which maps to the measure dimension in the OLAP metaoutline,
which in turn maps to the accounts dimension in the Hyperion Essbase outline.

measures dimension. In Essbase Integration Services, adimension that, by
default, maps to the accounts dimension in the Hyperion Essbase outline.
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member. A discrete component within adimension. For example, atime
dimension might include such members as Jan, Feb, and Qtrl.

member combination. In Hyperion Essbase, alist of member names used to
specify a set of data at the intersection of two or more dimensions. A member
combination is specified by using the cross-dimensional operator -> (a hyphen
followed by aright-angle bracket). For example, the actual sales datafor the
month of January in Sample Basic is Sales->Jan->Actual.

member level. A hierarchical level of detail within adimension. For example, in
adimension that defines geographic areas by nation, which are then subdivided
into provinces, the nation and province categories each represent a member level.
A member level correspondsto alevel in aHyperion Essbase outline. The
measures dimension contains actual members that are also member levels.

member load. In Essbase Integration Services, the process of adding new
dimensions and members (without data) to a Hyperion Esshase outline. Contrast
with data load.

metadata. A set of datathat defines and describes the properties and attributes of
the data stored in adatabase or used by an application. Examples of metadata are
dimension names, member names, properties, time periods, and security.

metaoutline. In Esshase Integration Services, atemplate containing the structure
and rules for creating a Hyperion Essbase outline from an OLAP model.

missing data (#M1SSING). A marker indicating that datain the labeled location
does not exist, contains no meaningful value, or was never entered or loaded. For
example, missing data exists when an account contains data for a previous or a
future period but not for the current period.

Move mode. In Essbase Integration Services, a state in which you can pick up,
move, and drop objectsin the OLAP Model main window.

multidimensional. Describesamethod of referencing datathrough three or more
dimensions. Anindividual datavalueistheintersection of one member from each
dimension.

multidimensional database (MDDB). A method of organizing, storing, and
referencing data through three or more dimensions. An individua value isthe
intersection of a point for a set of dimensions.

normalization. The process of grouping and removing redundancy from data so
that each entity isin itsappropriate place in the database and only initsappropriate
place. Contrast with denormalization.
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numeric transformation. In Essbase I ntegration Services, a set of instructions
that define how to change or reformat arelational database numericfieldtype. For
example, you may choose to divide numeric data by 100.

ODBC. See Open Database Connectivity (ODBC).

ODBC data source. Location of the data that you are accessing and the
information necessary to access the data using ODBC. For example, an ODBC
datasourcethat connectsto an SQL Server might requireaserver name, adatabase
name, a user name, and a password. See also Open Database Connectivity.

OLAP. Seeonlineanalytical processing (OLAP).

OLAP Architect. See Esshase Integration Services Console.

OLAP Builder. See Esshase |ntegration Services Console.

OLAP Catalog. See OLAP Metadata Catal og.

OLAP Command Interface. See Essbase Integration Services Shell.

OLAP Metadata Catalog. In Esshase Integration Services, arelational database
containing metadata describing the nature, source, location, and type of data that
you pull from the relational data source. Essbase Integration Server accesses the
OLAP Metadata Catal og to generate the SQL statements and the information
required to generate a Hyperion Essbase database outline.

OLAP model. InEsshase Integration Services, alogical model (star schema) that
you create from tables and columnsin arelational database. Y ou can then use the
OLAP model to generate the structure of a multidimensional database.

OLAP Server log. A record of actions performed by the OLAP Server (agent).
OLTP. Seeonline transaction processing (OLTP).

online analytical processing (OLAP). A multidimensional, multi-user,
client-server computing environment for users who need to analyze consolidated
enterprise data. OL AP systems feature functionality such as drilling down, data
pivoting, complex calculations, trend analyses, and modeling.

onlinetransaction processing (OLTP). OLTP applications are commonly
referred to as data capture, data entry, or data collection applications. OLTP
applications enable an organization to capture the large amounts of data resulting
from its daily activities but provide limited capability for reporting on the data.

Open Database Connectivity (ODBC). Standardized application programming
interface (API) technology that allows applications to access multiple third-party
databases.
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outline. The structure that defines all elements of a database within Hyperion
Essbase. For example, an outline contains definitions of dimensions, members,
and formulas.

parent. A member that has an aggregated branch of children below it.

pass-through transformations. In Essbase Integration Services, afeature that
allows you to use functions specific to your relational database management
system (RDBMS) to extract data valuesfor columns. Y ou can provide a statement
that Essbase Integration Server passes through to your RDBM S as a part of the
SQL SELECT statement. Y ou provide the statement as a property of acolumn and
the pass-through feature returns a value for the column.

permission. A special privilegethat must be assigned to users or groupsto enable
them to access or modify secure data. Permissions include Read, Read/Write and
None.

physical column. A column that is stored in arelational database. See also
column. Contrast with logical column.

physical table. A combination of rows and columns stored in arelational
database. Contrast with logical table.

pointer. Inrelational databases, adata element that indicates the location of data
in storage.

primary dimension table. A dimension tablethat joinsdirectly to the fact table.
Additional dimension tables may join to the primary dimension table to create a
dimension branch.

primary key. Inrelational databases, acolumn (key) that uniquely identifiesa
row. For example, Employee ID.

query governor. An Esshase Integration Server parameter or Essbase OLAP
Server configuration setting that you set to control the duration and size of the
gueries made to the data source.

RDBMS. Seerelational database management system (RDBMYS).

record. A set of information in a data source. Records are composed of fields,
each of which contains one item of information. A set of records constitutes a
table. A single record constitutes arow in the table. For example, atable
containing personnel information might contain records (rows) that have three
fields: aNAME field, an ADDRESS field, and a PHONE_NUMBER field.
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recursivetable. A source relational table that contains information in one row
that isa parent or child of information in another row. For example, in arelational
source table containing the columns EMPLOY EE_ID, NAME, and
MANAGER _ID, the columns EMPLOYEE_ID and MANAGER _ID are
recursive because MANAGER_ID refers back to the EMPLOY EE_ID. Using
Essbase I ntegration Services, you can build a Hyperion Essbase outline hierarchy
from arecursive source table.

relational database. A type of database that stores data in the form of related
tables. A single database can be spread across several tables, and can beviewed in
many different ways. Contrast with multidimensional database (MDDB).

relational database management system (RDBMS). A database management
system for accessing datain arelational database and storing datain the form of
related tables. A RDBM S takes SQL statements entered by a user or contained in
an application program and creates, updates, or provides access to the relational
database.

restructure. In Hyperion Essbase, an operation to regenerate or rebuild the
database index and, in some cases, the datafiles.

right frame. Inthe Essbase Integration Services Console OLAP Metaoutline
main window, the areaon theright, in which you build ametaoutling; Inthe OLAP
Model main window, the area on the right, in which you build an OLAP model.

schema. Inrelational databases, alogical model that represents the data and the
relationships between the data.

server. See Essbase OLAP Server and Essbase | ntegration Server.

shared member. A member that shares storage space with another member of the
same name. The shared member has a property that designates it as shared. The
use of shared members prevents duplicate cal culation of members that appear
more than once in an Essbase outline.

sibling. A child member at the same generation as another child member and
having the same immediate parent. For example, the members Florida and New
Y ork are both children of the member, East, and siblings of each other.

sparse dimension. A dimension unlikely to contain datafor all combinations of
dimension members. For example, product and market dimensions are sparse if
not all products are sold in all markets. Contrast with dense dimension.

SQL. Seealso Structured Query Language (SQL).
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SQL Override. InEssbaselntegration Services, afunction that enables editing of
the standard SQL statements generated by Essbase | ntegration Server for
drill-through reports. ODBC SQL, Native SQL , and stored procedures can be used
when editing the standard SQL . The edited, user-defined SQL can be selected to
improve data load performance when loading data into a Hyperion Esshase
database.

staging area. A database that you create to meet the needs of a specific
application. A staging areais a snapshot or restructured version of one or more
RDBM Ss.

standard dimension. A dimension that is not an attribute dimension.

star schema. A logical modd that represents your relational datain aform that
mirrors that of OLAP data. A star schema contains afact table and one or more
dimension tables.

string. A sequence of characters treated as a unit.

Structured Query Language (SQL). A computer language used to access data
in relational databases.

system administrator. A person who maintains the hardware, software, disk
space distribution, and configurations for running software applications such as
Esshase.

table. Inrelational databases, aform of data storage in which datais stored in
records comprised of fields. Each record is defined by a unique, or primary, key.

transformation rules. In Esshase Integration Services, a set of instructions that
define how to change or reformat the member names and data you extract from the
source relational database.

UDA. A user-defined attribute. A UDA is aterm associated with members of an
outline to describe a particular characteristic of the members. Users can specify
UDAs within calculation scripts and reports so that they return lists of members
that have the specified UDA associated with them. UDASs can be applied to dense
aswell as sparse dimensions.

unary operator. A group of mathematical indicators (+, -, *, /, %) that define
how roll-ups take place on the database outline.

union. An SQL command that is atype of join that combines the results of two
SELECT statements. A union is often used to merge lists of values contained in
two tables.
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user -defined dimension. Dimensions that you explicitly create in Essbase
Integration Services, rather than dimensions obtained or built from the relational
data source.

user -defined member. Membersthat you explicitly createin Essbase Integration
Services, rather than obtaining and building them from the relational data source.

user -defined tables. Logical tables that you create in Essbase Integration
Services, rather than in the RDBMS. These virtual tables, which behave as
standard RDBM S views, can be used anywhere regular RDBM S tables or views
are used. User-defined tables enable you to create and to edit OLAP models
without altering your relational schema or modifying the SQL generated by
Integration Services.

validation. (1) In Hyperion Esshase, aprocess of checking arulesfile against the
outline to make sure therulesfileisvalid. (2) In Essbase Integration Services, a
process of checking the OLAP model and metaoutline.

view. Inrelational databases, alogical table created by combining columns from
one or moretables. A view can contain metadata and formatting information used
to query an OLAP data source.

virtual tables. See user-defined tables.
virtual views. See user-defined tables.

XML Import/Export. In Essbase Integration Services, afunction that enables
importing data into and exporting data from an OLAP Metadata Catalog in
Extended Markup Language (XML) file format. Both OLAP models and
metaoutlines can be saved as XML files and imported into other OL AP M etadata
Catalogs.
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A

access
codes, for metaoutlines, 37
codes, for OLAP models, 35
exclusive access mode, 31
multi-user, 30
privileges, common problems, 40
problems, correcting, 60
setting, 34
standard access mode, 30
accessing
data sources, 40
OLAP Metadata Catalog, 40, 42
servers and databases, troubleshooting, 39
accounts
problemsin the RDBMS, 47
user, administrative, 47
user, problems, 61
administrative accounts, using, 47
Architect. See Essbase Integration Services Console
AT service, 106 to 107
audience, skills required, vii

B

backtracking connection problems, 44
backups, OLAP Metadata Catalog, 74
bat extension files, 89
batch files
Essbase Integration Services Shell and, 85
running, 89
running Essbase I ntegration Services Shell
scripts with, 89
scheduling manually, 106 to 107
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batch mode, Essbase Integration Services Shell, 85

binding, requirement for DB2 databases, 64

brackets, in Essbase Integration Services Shell
syntax, 88

buffer size. Seefetch size

Builder. See Esshase Integration Services Console

C

catalog. See OLAP Metadata Catalog
CB_CONCURRENCY table
column descriptions, 32
defined, 82
CB_OBJECT_TY PE column, data defined, 32
CB_VERSION table, 82
cbs extension files, 89
checking
common connection problems, 40
release number of Essbase Integration Services,
54
script syntax for loads, 88
client software
port number, 68
problems, correcting, 68
RDBMS, common problems, 40
RDBMS, correcting problems, 63
troubleshooting, 39
codes, access
for metaoutlines, 37
for OLAP models, 35
command line
Essbase Integration Services Shell, 84 to 85
|oading data from, 107
|oading members from, 106
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command line parameters, for OLAPISVR. See
switches
command syntax, Essbase | ntegration Services Shell,
87
command-line interface, using, 83
commands, Esshase Integration Services Shell, 91
commands, status of, 92
common problems
areas of failure, 43
database-specific, 42
with connections, 40
communication problems, 43
compatibility
between RDBMS and RDBMS client, 63
ODBC drivers, 65
problems with product versions, 54
components, software, common problems, 40, 43
concurrent users, 32
configuration problems (ODBC), 43
connecting
database client to RDBMS, 46
problems with data source, 40, 42
problems with OLAP Metadata Catal og, 40, 42
connections
areas of failure, 43
common problems, 40
isolating problems, 44
LOADMEMBER command, 54
OLAP Metadata Catalog, 40, 42
path through components, 45
problems, correcting, 60
problems, diagnosing, 43
problems, isolating, 44
testing, 48, 56
troubleshooting, 39
consulting services, xii
correcting
connection problems, 39, 60
data source problems, 65
database client problems, 63
Essbase Integration Server problems, 67
Essbase Integration Services Console problems,
68
ODBC problems, 39, 65
password problems, 61
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RDBMS problems, 62

user name problems, 61
critical server error messages, 22
cron scheduling daemon, 106

D

data loads
checking script syntax, 88
command line and, 108
error messages, 113
Esshase | ntegration Services Shell and,
106 to 107
incremental, script syntax, 91
LOADALL command, 101
LOADDATA command, 98
OLAP Metadata Catalog and, 15, 74
optimizing, 19
scripts, recording, 88
time required, 87
data sources
accessing, 40
connecting to, 106 to 107
connection problems, 40, 42
connections to, diagram, 45
identifying before loading, 93
problems, correcting, 65
data, retrieving, 15
database client software
common problems, 40
environment problems, 46, 64
problems, correcting, 63
testing connection to RDBMS, 46
database servers
common problems, 40
problems, correcting, 62
database users, source, 29
databases
connections to, diagram, 45
vendor-specific problems, 42
DB2
common problems, 42
database binding requirement, 64
debug messages, 22
Delete Locks command, 32
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deleting

Essbase Integration Server users, 30

locks, 32, 34

read and write locks, 34

users, 30
DemoODBC program, 48
diagnosing problems (connections, ODBC), 39
diagram, connections path, 45
disconnecting, users, 30
DNS, problems, 44
domain name server, problems, 44
drill-through reports

error messages, 113

tablesrelating to, 80
driver file, ODBC, specifying on UNIX, 53
drivers, ODBC, problems, 65
DTR_ATTRIBUTES table, 80
DTR_INFO table, 80

E

eis.cfgfile, 16, 18
described, 24
storing startup switch settings, 25
environment variables
common problems, 40
for database client, problems, 46, 64
ODBC problems, 48
€rror messages
dataload, 113
drill-through reports, 113
member load, 109
miscellaneous server messages, 116
OLAPICMD program, 115
setting logging level, 22
Shell commands, 115
Esshase
messagefile, 28
relationship to Essbase Integration Server, 15
server name problems, 60
server, connecting to, 107
server, message database, 23
target data server, specifying, 94
testing connection from Esshase I ntegration
Server to OLAP Server, 57
users, defined, 29

Essbase Integration Server

common problems, 40

defined, 15

determining user access, 33

error messages, 109

executable name, 16

fetch size for loads, 19

log files, 27

logging on to, 92, 106 to 107

logging out of, 105

OLAP Metadata Catalog, information in, 74
port number, 24, 68, 84
prerequisites for, 16

problems, correcting, 67

reconnecting to, 26

server problems, 60

shutting down, 26, 105

starting, 16, 26

starting as a Windows service, 17
starting from the command line, 16
starting from the Windows Desktop, 17
startup switches, 19

stopping, 26

stopping as a Windows Service, 27
stopping from command line, 26
stopping from Windows Desktop, 26
switches, 19

testing connection to OLAP Server, 57
testing connection to RDBM S, 53

Essbase Integration Server users

defined, 29
deleting, 30
disconnecting, 30
multiple, 32
viewing locks, 32

Essbase Integration Services

connection path, diagram, 45
release number, checking, 54

Essbase Integration Services Console

common problems, 40

port number, 24, 68, 84

problems, correcting, 68

testing connection to Essbase OLAP Server, 59
testing connection to RDBM S, 56
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Essbase Integration Services Shell
asynchronous commands, 92
batch mode, 85
command syntax, 87
commands, list, 91
description, 85
executable name, 84
executing commands, 87
information, 83
interactive mode, 86
loading data with, 107
loading members with, 106
running scripts with, 89
starting, 84
using to test connections, 54

Essbase I ntegration Services Shell commands
EXIT, 106
LOADALL, 101
LOADDATA, 98
LOADMEMBER, 95
LOGIN, 92
LOGOUT, 105
SETCATALOG, %4
SETSOURCE, 93
SETTARGET, 94
SHUTDOWN, 105
STATUS, 92
syntax, 87
VERSION, 93

Essbase Integration Services users
creating, 30
viewing, 30

Essbase OLAP Server, connecting to, 107

esshase.mdb file, 23, 28

exclusive access mode, 31

executable name
for Essbase Integration Server, 16
for Essbase Integration Services Shell, 84

EXIT command, 106

extralocks
deleting, 34
viewing, 32

F

fetch size, setting for Essbase Integration Server, 19
file name, Essbase messages file, 21
file names, 23
files
batch. See batch files
log. Seelog files
script. See scripts
fixing. See troubleshooting

H

host names, problems, 60

Hybrid Analysis, defined, 81

Hybrid Analysis, tablesrelating to, 81

Hyperion Esshase. See Esshase

Hyperion Integration Server Intelligent Desktop. See
Essbase Integration Services Console

Hyperion Integration Server. See Essbase I ntegration
Services

incompatibility, problems with product versions, 54
incremental |oads
LOADALL command, 101
LOADDATA command, 98
LOADMEMBER command, 95
script syntax, 91
informational messages, 22
Integration Server. See Essbase Integration Server
interactive mode, Esshase I ntegration Services Shell,
86
INTERSOLV. See MERANT, ODBC driver
problems, correcting
introduction, vii
is.cshfile, using, 51
is.shfile using, 51
isolating, connection problems, overview, 44
ivtestlib program, 48

J

JOIN_HINTSttable, 77
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levels of access permissions, 35
library path, common problems, 41
listeners, setting, 24
LOAD commands, 86 to 87
LOADALL command, described, 87, 101
LOADDATA command
described, 87, 98
example of, 108
loading
data, optimizing, 19
data, time required, 87
Essbase Integration Services Shell and,
106 to 107
from the command line, 107
OLAP Metadata Catalog and, 15, 74
test, membersinto Esshase database, 57
LOADMEMBER command
connections made by, 54
described, 87, 95
example of, 107
using to test connections, 54
locks
deleting, 32, 34
exclusive access mode, 31
metaoutlines, 30
OLAP models, 30
read, deleting, 34
read, viewing, 33
standard access mode, 30
storage location in the OLAP Metadata Catalog,
32
timestamps and, 32
unreleased, 32
viewing, 32
working with, 29 to 30
write, deleting, 34
write, viewing, 33
log files
changing name and location, 21
contents, 27
Essbase Integration Server, viewing, 27
messages recording level, 22
logging level, 22
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LOGIN command
described, 92
example of, 106 to 107
login problems, correcting, 61
login script
diagnosing problems, 51
problems, 46
LOGOUT command, 105

M

managing
locks and permissions, 29
user names and passwords, 61
MB_FILTER table, 75
MB_TX_RULE table, 75
member loads
checking script syntax, 88
command line, 106 to 107
error messages, 109
LOADMEMBER command, 95
OLAP Metadata Catalog and, 15, 74
scripts, recording, 88
MERANT, ODBC driver problems, correcting, 65
message file, Essbase, 28
messages, debug, 22
messages, error, 109
metaoutlines
access codes, 37
access permissions, 34
locks, 30
opening in exclusive access mode, 31
opening in standard access mode, 30
overwriting, 31
permissions, viewing, 36
restoring, 74
tablesin OLAP Metadata Catalog, 77
users, 32
MO_ACCESS_CODE column, data defined, 37
MO_DESCRIPTIONS table, 79
MO_FILTERS table, 78
MO_INFO table, 36, 78
MO_INTERSECTION table, 80
MO_PROPERTIES table, 78, 80 to 81
MOD_ATTRIBUTEStable, 78
MOD_INFO table, 78
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Model. See OLAP models
MODEL_ACCESS_CODE column
data defined, 35
MS_INFO table, 79
MS PREDICATES table, 79
MS_TX_RULE table, 79
MSR_INFO table, 79
MSR_PREDICATES table, 79
MSR_TX_RULE table, 79
multi-threaded server, 15
multi-user access, 30

N

names, server problems, 60
network listeners, setting, 24
network problems, 44
non-critical error messages, 22

O

OA_INFO table, 75
OD_DETAILStable, 75
OD_INFO table, 76
ODBC
common problems, 41
driver compatibility, 65
driver file, specifying on UNIX, 53
environment problems, 46
problems, correcting, 65
testing connection to RDBMS, 48
testing on UNIX, 49
testing on Windows, 48
tracing on UNIX, 71
tracing utility, using, 70
troubleshooting, 39
ODBC Administrator, 48
ODBC Data Sources, odbc.ini file secti
odbc.ini file
common problems, 48
inspecting for problems, 52
Trace parameter, 71
odbcconfig utility, 49
ODBCINI variable, 52

OLAP Architect. See Esshase Integration Services

Console
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OLAP Builder. See Esshase Integration Services
Console
OLAP Catalog. See OLAP Metadata Catalog
OLAP Command Interface. See Esshase Integration
Services Shell
OLAP Command Script files, 89
OLAP Integration Server. See Essbase Integration
Server
OLAP Metadata Catalog
accessing, 29
backups, 74
connecting to, 107 to 108
connection problems, 40, 42
deleting locks, 34
drill-through tablesin, 80
Esshase | ntegration Server and, 15
Hybrid Analysistablesin, 81
identifying before loading, 94
manual editing, 74
metaoutline tables, 77
OLAP model tables, 75
problems, database level, 62
recovery, 74
viewing permissions, 36
OLAP metaoutline. See metaoutline
OLAP models
access codes, 37
access permissions, 34
accessing, 29
locks, 30
opening in exclusive access mode, 31
opening in standard access mode, 30
overwriting, 31
permissions, viewing, 35
restoring, 74
tablesin OLAP Metadata Catalog, 75
users, 32 to 33
OLAPICMD program
error messages, 115
problems, 54
starting, 84
OLAPISVR program
command-line switches, 19
starting, 16
olapisvr.log file, specifying location, 21
OM_DESCRIPTION table, 77

on, 52
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OM_INFO table, 35, 76
OM_PROPERTIES table, 76
OMB_DETAILStable, 76
OMB_INFO table, 76
opening metaoutlines, options, 30
opening OLAP models, options, 30
optimizing, data loads, 19
Oracle
common problems, 42
tnsnames.orafile, 64
orphaned locks, deleting, 32, 34
OV_INFO table, 76
overwriting, OLAP models and metaoutlines,
problem, 31
OVL_REL_DETAILStable, 76
OVL_REL_INFO table, 76
OVP_REL_DETAILStable, 77
OVP_REL_INFO table, 77

P

parameters, for OLAPISVR. See switches
password problems, 40, 61
performance, enhancing, data loads, 19
permissions
changing, 35
for metaoutlines, 34, 36
for OLAP models, 34
problemsin the RDBMS, 47
shutting down Essbase | ntegration Server, 105
viewing, 34
working with, 29
port 3388, 24, 68, 84
prerequisites
Essbase Integration Services Shell, 84
for Essbase Integration Server, 16
for using this guide, vii
primary data source, 93
privileges, common problems, 40
problems
starting Essbase Integration Server, 16
system-level, 60
TCP/IP, 44
with connections, correcting, 39, 42
with ODBC, correcting, 39, 43, 63
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problems. See al so troubleshooting
profilefile, 51

R

RDBMS
client problems, correcting, 63
common problems, 40
problems, correcting, 62
server name problems, 60
testing connection from database client, 46
testing connection from Essbase Integration
Server, 53
testing connection from Esshase Integration
Services Console, 56
testing connection to ODBC, 48
testing ODBC connection on UNIX, 49
testing ODBC connection on Windows, 48
user account problems, 47
read access, setting, 34
read locks
deleting, 34
viewing, 33
reconnecting to Essbase Integration Server, 26
recording data load scripts, 88
recording scripts, 88
recovery, OLAP Metadata Catalog, 74
relational database management system. See
RDBMS
relational databases
connectionsto, diagram, 45
problems, correcting, 62
releases
compatibility problems, 54
determining for Essbase Integration Services, 93
restoring
metaoutlines, 74
OLAP Metadata Catalogs, 74
OLAP models, 74
right-click menus, xi
rights, problemsin the RDBMS, 47
running
Essbase Integration Server, 16, 26
Essbase Integration Services Shell, 84
scripts with Essbase I ntegration Services Shell,
89
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S

scheduling, batch files for loads, 106 to 107
scripts
incremental loads, syntax, 91
member and data |oads, recording, 88
running with Esshase Integration Services Shell,
89
secondary data source, 93
security
access permissions, 34
locks, 30
problems, 44
semicolons, in Essbase I ntegration Services Shell
syntax, 88
server problems, 60
server software
port number, 68
problems, correcting, 67
troubleshooting, 39
Servers menu, OLAP Metadata Catalog, Delete
Locks command, 32
SET commands, 86
SETCATALOG command
described, 86, 94
example of, 107 to 108
SETSOURCE command
described, 86, 93
example of, 106 to 107
SETTARGET command
described, 86, 94
example of, 107
setting
data source, 106 to 107
Essbase OLAP Server, 107
network listeners, 24
OLAP Metadata Catalog, 94, 107 to 108
primary data source, 93
secondary data source, 93
target Essbase OLAP Server, 94
SHUTDOWN command, 26, 105
shutting down Esshase I ntegration Server, 26, 105
software components
common problem areas, 43
connection problems, 40
source database users, 29

140 m

JKLMNOPQRSTUVWXY Z

SQL Server, common problems, 42
standard access mode, 30
starting
Esshase | ntegration Server, 16, 26
Esshase | ntegration Server, methods, 16
Esshase | ntegration Server, programs necessary,
16
Esshase | ntegration Services Shell, 84
startup switches for Esshase Integration Server, 19
STATUS command, described, 87, 92
stopping Essbase Integration Server, 26
stopping, Esshase Integration Server, 26
storage
metaoutline, 74
OLAP model, 74
switches, for OLAPISVR, 19
syntax, Essbase Integration Services Shell
commands, 87
system variables. See environment variables
system-level problems, 60

T

tables
drill-through, 80
Hybrid Analysis, 81
metaoutline, 77
miscellaneous, 82
OLAP model, 75
read-only, 74
TCP/IP problems, 44
testing
connections, overview, 44
database client, 46
Esshase I ntegration Server connection to Esshase
OLAP Server, 57
Esshase | ntegration Server connection to
RDBMS, 53
Essbase I ntegration Services Console connection
to RDBMS, 56
Esshase | ntegration Services Console to Esshase
OLAP Server, 59
ODBC connection to RDBMS, 48
ODBC on UNIX, 49
ODBC on Windows, 48
timestamp, locks and, 32
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tnsnames.orafile, 64
Trace parameter, odbc.ini file, 71
tracing utility

ODBC for UNIX, 71

ODBC for Windows, 70
troubleshooting

connections, 39

ODBC, 39

system-level problems, 60

TCP/IP, 44
troubl eshooting. See also problems
turning off Essbase Integration Server, 26

U

UNIX
ODBC tracing, 71
odbcconfig utility, 49
testing ODBC, 49
unreleased locks, deleting, 32, 34
user accounts, administrative, 47
user names
locks and, 32
problems with, 40, 61
users
deleting, 30
disconnecting, 30
Essbase Integration Server, defined, 29
Essbase, defined, 29
managing permissions and locks, 29
multiple, 32
source database users, 29

Vv

variables. See environment variables
VERSION command, described, 87, 93
versions, compatibility problems, 54
viewing

log files, 27

permissions for metaoutlines, 36

permissions for OLAP models, 35

W

warning messages, 22
Windows
ODBC testing, 48
ODBC tracing, 70
testing ODBC, 48
Windows service
using to pass startup switches, 17
using to start Integration Server, 17
using to stop Integration Server, 27
write access, setting, 34
write locks
deleting, 34
viewing, 33
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